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ABSTRAK 

 

Bendungan merupakan konstruksi yang dibangun 

untuk menahan laju air menjadi waduk, bendungan umumnya 

bertujuan untuk pemanfaatan air baku, irigasi, pembangkit 

listrik maupun untuk pengembangan wisata daerah.  

Dalam perencanaan bendungan harus direncanakan 

semaksimal mungkin dan dari segi keamanan harus 

direncanakan seaman mungkin saat pembangunan maupun 

saat beroperasi. Begitu pula dengan pembangunan Bendungan 

Tugu Kabupaten Trenggalek. 

Dalam tugas akhir ini “Prediksi dan Analisis 

Rembesan pada Tubuh Bendungan Tugu Kabupaten 

Trenggalek” tubuh bendungan yang dimaksut adalah 

bendungan potongan besar (STA 07) dan bendungan potongan 

kecil (STA 17).  

Perencanaan harus memperhatikan parameter 

rembesan apalagi Bendungan Tugu Kabupaten Trenggalek 

merupakan bendungan dengan tipe urugan, dimana material 

tanah sebagai timbunannya, ini mengakibatkan adanya pori 

yang dapat mengakibatkan terjadinya rembesan. Rembesan 

melalui pori inilah yang membahayakan, karena aliran air 

yang merembes dapat membawa material yang lama kelamaan 

dapat mengakibatkan keruntuhan bendungan. Ini dapat diatasi 

salah satunya dengan cara menganalisis menggunakan aplikasi 
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Geo Studio, aplikasi ini dapat mengidentifikasi alur garis 

depresi maupun kecepatan dan debit rembesan yang melalui 

tubuh bendungan. 

Analisis meliputi kondisi Muka Air Banjir (MAB), 

Muka Air Normal (MAN), Surut Cepat dan Dead Storage. 

Debit rembesan yang diijinkan harus lebih kecil dari 1% 

dari debit banjir rata-rata tahunan, sedangkan untuk 

longsoran akibat adanya rembesan yang diijinkan berdasarkan 

SNI 2002 (MAB= 1,3, MAN= 1,5, Surut Cepat= 1,2, Dead 

Storage setinggi MAN= 1,5) 
Perhitungan menunjukkan hasil (a) debit air yang 

merembes pada permodelan sudah lebih kecil dari debit 

rembesan yang diijinkan untuk merembes (b) angka keamanan 

terhadap longsoran banyak yang belum melebihi angka 

keamanan yang diijinkan dari SNI 2002, (c) dimensi butiran 

yang terbawa rembesan sudah lebih kecil dari material agregat 

timbunan tubuh bendungan (d) angka keamanan terhadap 

sufosi dan boiling lebih dari 4,00 

 

Kata kunci: Waduk, Bendungan Tugu Trenggalek, Garis 

Depresi, MAB, MAN, Surut Cepat, Dead Storage 
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ABSTRACT 

 

 Dam is a construction that built for holding water to 

become a reservoir, dams generally aiming for the utilization 

of raw water, irrigation, power generation and for the 

development of regional tourism.  

 In planning the dam should be planned as much as 

possible and in terms of security should be planned as safe as 

possible during construction and while operating. Similarly, 

the construction of Trenggalek’s District Tugu Dam. 

 In this final project “Prediction and Analysis 

Seapage of Trenggalek’s Distric Tugu Main Dam” the main 

dam that in question is big cut dam (STA 07) and small cut 

dam (STA 17). 

 The planning must considering the seep parameter, 

moreover Trenggalek’s District Tugu Dam is a soil pile dam, 

which is make the dam have pores that can lead to seeping. 

This seepage is very dangerous, because the water flow that 

seeping repeatedly will cause the dam to collapse. It can be 

solved by analyse using software GeoStudio, this software 

could identify the flownet of the seepage and also the speed 

and debit of the seepage that through the body dam.  

 The analysis includes the condition of Flood Water 

Front (MAB), Normal Water Front (MAN), Rapid Surge and 

Dead Storage. The permissible seepage permit must be less 
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than 1% of the average annual flood discharge, whereas for 

avalanches due to permissible seepage based on SNI 2002 

(MAB = 1,3, MAN = 1.5, Fast Surge = 1.2, Dead Storage as 

MAN = 1.5) 

 The calculation shows the result (a) the water debit 

seeping on the model is more than the permitted seepage 

permeability (b) the security number against the landslide has 

not exceeded the allowable security level of SNI 2002 yet (c) 

the permeable granular dimensions are smaller than the dam 

aggregate material (d) the security number of the sufosi and 

boiling is more than 4.00. 

Keywords: Reservoir, Tugu Trenggalek Dam, Depression 

Line, MAB, MAN, Receded Fast, Dead Storage 
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BAB I PENDAHULUAN 

 

1.1. Latar Belakang 

 

Merembesnya air(seepage) pada suatu 

pertikel dapat menyebabkan peningkatan massa jenis 

pertikel tersebut atau bahkan dapat menyebabkan 

reaksi kimia yang dapat merugikan. Jika hal ini terjadi 

pada pertikel dengan skala besar seperti bendungan 

yang sebelumnya diperhitungkan dengan seksama 

dapat menimbulkan perbedaan perhitungan yang 

signifikan. 

 

Bendungan Tugu Trenggalek merupakan 

bendungan tipe urugan zonal dengan inti tegak, 

bendungan tipe urugan ini merupakan timbunan 

beberapa material campuran maupun material 

seragam, tentunya bendungan tipe urugan berbeda 

dengan bendungan tipe beton, yang mana bendungan 

tipe beton materialnya sudah bisa dipastikan tidak 

tembus air meskipun tembus air pasti sedikit, berbeda 

dengan bendungan tipe urugan yang materialnya 

memiliki pori atau void lebih besar dibandingkan 

beton, maka perlu dilakukan perhitungan yang 

terperinci mengenai hal tersebut, agar tidak terjadi 

hal-hal yang merugikan. Rembesan air (seepage) yang 

berbahaya terhadap tubuh bendungan adalah 

rembesan yang mengikis material pembentuk tubuh 

bendungan(erosi). 

 

Berdasarkan permasalahan tersebut, maka 

perlu dilakukan suatu analisis secara menyeluruh 

terhadap rembesan (seepage) yang terjadi. Pada kajian 

ini ditinjau seepage pada Tubuh Bendungan Tugu, 

Kabupaten Trenggalek, Provinsi Jawa Timur. Adapun 

tujuan dari kajian ini adalah untuk meninjau dan 

menganalisis seepage yang terjadi. Berdasarkan 
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tujuan tersebut maka manfaat dari analisis ini 

adalahmengetahui pengaruh tinggi muka air terhadap 

rembesan yang terjadi.Perhitungan dilakukan 

menggunakan software GEO (SEEP/W) yang dapat 

mengetahui  rembesan yang terjadi di bendungan. 

GeoStudio adalah rangkaian produk 

perangkat lunak dari Geo-Slope International Ltd. 

yang dapat digunakanuntuk mengevaluasi kinerja 

bendungan atau tanggul dengan berbagai tingkat 

kompleksitas. SEEP/W adalah salahsatu elemen dari 

produk GeoStudio dengan basic CAD terbatas untuk 

menganalisis rembesan air dan masalahdisipasi 

tekanan air pori berlebih dalam bahan berpori seperti 

tanah dan batuan. Formulasi yang komprehensif 

memungkinkan dapat mempertimbangkan analisis 

mulai dari yang sederhana, masalah kondisi jenuh 

steady-statesampai dengan masalah kondisi jenuh 

atau tidak jenuh yang tergantung pada waktu. 

SEEP/W dapat diterapkanpada analisis dan desain 

untuk geoteknik, sipil, hidrogeologi, dan kegiatan 

rekayasa pertambangan.(Anonim, 2007) 

Sehingga parameter rembesan suatu 

bendungan tidak bisa dianggap “sebelah mata” saat  

pendesainan.  Bendungan Tugu  kabupaten 

Trenggalek yang mana mendapat rekor MURI sebagai 

bendungan dengan letak tertinggi di Indonesia ini 

dapat mengakibatkan jangkauan jebolnya bendungan 

semakin jauh sehingga secara otomatis semakin luas 

dampak dan banyaknya korban yang akan disebabkan. 
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1.2. Rumusan Masalah 

1.2.1. Berapa rembesan yang terjadi pada bendungan 

Tugu kabupaten Trenggalek dengan permodelan 

: 

a. Muka Air Banjir, 

b. Tinggi Elevasi Mercu,  

c. Surut cepat, 

d. Dead Storage. 

1.2.2. Bagaimana rembesan yang terjadi untuk 

masing-masing permodelan sebagaimana point 

nomer 1.2.1. pada bendungan Tugu kabupaten 

Trenggalek? 

1.2.3. Berapa batas kritis diameter butir sebelum 

terbawa rembesan? 

 

1.3. Tujuan 

1.3.1. Mengetahui jumlah rembesan yang terjadi pada 

bendungan Tugu kabupaten Trenggalek untuk 

masing-masing permodelan sebagaimana point 

subbab 1.2.1. 

1.3.2. Menganalisis rembesan yang terjadi pada 

bendungan Tugu kabupaten Trenggalek untuk 

masing-masing permodelan sebagaimana pont 

subbab 1.2.1. 

1.3.3. Mengetahui batas kritis diameter butir sebelum 

terbawa rembesan. 

 

1.4. Manfaat 

1.4.1. Mengetahui tata cara penggunaan software 

GeoStudio SEEP/W dan SLOPE/W. 

1.4.2. Mengetahui Safety of factor dari terjadinya 

longsor. 

1.4.3. Mengetahui batas kecepatan kritis rembesan 

yang diijinkan. 

1.4.4. Menjadi bahan penelitian serupa selanjutnya. 
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1.5. Ruang Lingkup Penelitian 

1.5.1. Ruang Lingkup Wilayah 

Ruang lingkup wilayah pada daerah 

penelitian adalah software analisis rembesan air 

dan kestabilan lereng untuk menganalisis 

rembesan yang terjadi serta akibatnya pada 

kestabilan lereng, sedangkan untuk mengetahui 

batas kritis kecepatan rembesan menggunakan 

perhitungan manual. Software penelitian ini 

menggunakan GEO STUDIO SLOPE/W dan 

SEEP/W. 

 

1.5.2. Ruang Lingkup Penulisan 

Untuk menjaga agar pembahasan materi 

dalam tugas akhir ini lebih terarah, penulis 

menetapkan ruang lingkup penulisan sebagai 

berikut: 

I. Penelitian pemodelan menggunakan 

software GEO STUDIO SEEP/W  

mengenai perubahan kecepatan 

rembesan serta pola rembesan. 

II. GEO STUDIO SLOPE/W hanya 

digunakan untuk mengetahui 

pengaruh rembesan terhadap 

kestabilan bendungan. 

III. Menentukan batas kritis 

menggunakan perhitungan manual. 

 

 

 



 
 

5 
 

BAB II TINJAUAN PUSTAKA 

 

2.1. Dasar Teori 

 

2.1.1. Rembesan Air pada Pondasi Tubuh 

Bendungan 

 

2.1.1.1. Rembesan Air. 

Rembesan Air atau Permeabilitas adalah 

sifat bahwa zat cair dapat mengalir lewat bahan 

berpori. Tanah termasuk bahan permeabel 

sehingga air dapat mengalir melalui pori-pori 

tanah.derajat permeabilitas tanah ditentukan oleh 

Ukuran pori, jenis tanah dan kepadatan tanh yang 

dinyatakan dalam k (satuan kecepatan cm/s atau 

m/s). 

Air tanah adalah air yang berada pada 

lapisan di bawah permukaan tanah. Kedalaman air 

tanah di tiap tempat tidak sama karena 

dipengaruhi oleh tebal atau tipisnya lapisan 

permukaan di atasnya dan kedudukan lapisan air 

tanah tersebut. Air juga merupakan faktor yang 

sangat penting dalam masalah-masalah seperti: 

penurunan, stabilitas pondasi, stabilitas lereng, 

dll. Kedalaman air dapat dilihat dari sumur-sumur 

yang digali oleh penduduk. Permukaan bagian 

atas air itu lebih preatik.(Sukirman, 2014) 

 

2.1.1.2. Hubungan Rembesan Air dan Jenis 

Tanahnya. 

 

Aliran air dalam tanah pada umumnya 

berupa aliran laminer, maka berlaku hukum Darcy 

bahwa kecepatan berbanding langsung dengan 

gradien hidraulik.  
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Dengan, V  = kecepatan aliran (m/s) 

  i  = kemiringan lintasan  

  k = kofisien permeability (m/s) 

atau (cm/s) 

 

Nilai k untuk jenis-jenis tanah 

 

Tabel 2.1 Tabel Nilai k (koefisien permeability) 

Jenis Tanah K (mm/s) 

Butiran Kasar 10 - 10
3 

Kerikil halus, butiran kasar bercampur 

pasir butiran sedang 

10
-2

 – 10 

Pasir halus, lanau longgar 10
-4

 - 10
-2

 

Lanau padat, 

Lanau berlempung 

10
-5

 - 10
-4

 

Lempung berlanau, lempung 10
-8

 - 10
-5

 

(Mekanika Tanah I, Hardiyatmo Hary C.,2002) 

 

2.1.1.3. Perhitungan Batas Kritis 

“.. bila tekanan rembesan ke atas yang 

terjadi dalam tanah sama dengan ic maka tanah 

akan pada kondisi mengapung. Keadaan semacam 

ini juga dapat berakibat terangkutnya butir-butir 

tanah halus, sehingga terjadi pipa-pipa di dalam 

tanah  yang disebut piping..”,(Hardiyatmo, 2002) 

piping dapat menyebabkan rongga udara dalam 

bendungan yang secara signifikan dapat 

menurunkan tahanan tanah, yang mana sangat 

berbahaya bagi kestabilan bendungan. Berikut 

perhitungan kecepatan kritis yang diijinkan agar 

tidak terjadi gejala sufosi (piping) serta sembulan 

(boiling). 

 

Kecepatan Kritis yang diijinkan 

Kecepatan kritis aliran dihitung dengan rumus : 

Vc >Vs 
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Vc =
wF

gW1


 

dimana,  

Vc = Kecepatan rembesan kritis yang 

diijinkan. 

Vs = Kecepatan rembesan 

d = Diameter butiran terkecil  

W1 = (Gs - 1) x  
6

1
 x  x d

3
 

Gs = Gravity specific (berat jenis) 

g  = Gravitasi 

F  = luas penampang butiran terkecil 

γ  = Berat volume (gram/cm
3
)

 

 

Gradien Hidrolik Kritis 

i  =  
l

h
 

icr  =  
)e1(

)1Gs(




 

Keamanan terhadap piping 

FK =   
i

icr
 

Dimana,  

icr = Gradien keluar maksimum. 

h = beda tinggi air di hulu dan hilir 

l = panjang penampang basah arah 

memanjang. 
 

Keamanan terhadap kelongsoran lereng 

waduk dan rembesan (seepage) merupakan 

persyaratan utama untuk kestabilan waduk. Oleh 

sebab itu pembangunan waduk diupayakan tidak 

terjadi rembesan yang melewati batas rembesan 

yang diizinkan. Bila rembesan yang berlebihan ini 



8  
 

 
 

tidak diantisipasi dapat menyebabkan perubahan 

tegangan efektif pada massa tanah itu, sehingga 

akan terjadi tekanan rembesan (seepage force) 

yang menyebabkan lepasnya ikatan antar partikel 

tanah dan terbentuknya deformasi yang permanen 

pada tubuh waduk, maka dikhawatirkan dapat 

terjadi kelongsoran dan/atau keruntuhan waduk 

yang akan menimbulkan kerugian.(Sundary, 

2013) 

Dikarenakan data yang masih belum 

ditentukan dari pihak PU Dinas Pengairan BBWS, 

serta desain timbunan Bendungan Tugu yang 

masih mengalami perubahan, sehingga data 

timbunan tidak lengkap, penyusun Tugas Akhir 

kali ini memutuskan untuk parameter Gs (Spesific 

Gravity) diambil paling maksimal untuk setiap 

jenis material, sebagaimana tabel 2.2. 

Tabel 2.2 Tabel Nilai Spesific Gravity (Gs) 

Macam Tanah Berat Jenis (Gs) 

Kerikil 2,65 – 2,68 

Pasir 2,65 – 2,68 

Lanau anorganik 2,62 – 2,68 

Lempung organik 2,58 – 2,65 

Lempung anorganik 2,68 – 2,75 

Humus 1,37 

Gambut 1,25 – 1,80 

(Mekanika Tanah I, Hardiyatmo Hary C.,2002) 

 

2.1.2. Perhitungan Rembesan 

2.1.2.1. Persamaan Darcy 

Henri Darcy (Anonim, 2010), seorang 

ahli hidrolika dari Perancis mengadakan suatu 

percobaan aliran air yang melalui suatu lapisan 

tanah. Darcy berpendapat bahwa besarnya 

kecepatan aliran yang mengalir masuk ataupun 

keluar dari lapisan tanah sebanding dengan 
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gradien hidrauliknya. Hukum Darcy dinyatakan 

dalam persamaan, sebagai berikut: 

Q = k.i.A ........................................................... [1] 

V = k.i ............................................................... 

[2] 

Q = 
𝑁𝑓

𝑁𝑝
. 𝑘. 𝑕. 𝐿.....................................................[3] 

 

dengan : 

Q  = volume aliran air persatuan waktu yang 

masuk ataupun keluar (m3/s), 

k  = konstanta yang dikenal sebagai koefisien 

permeabilitas (cm/s), 

V  = kecepatan rembesan (cm/s), 

i  = gradien hidrolik, 

A  = luas penampang tanah yang dilewati (m2), 

Nf = angka pembagi dari garis trayektori aliran 

filtrasi 

Np = angka pembagi dari garis equipotensial. 

Semua jenis tanah dapat dilalui air 

melalui pori – pori tanah. Menurut Wesley 

(Azmeri dkk, 2013) permeabilitas didefinisikan 

sebagai sifat bahan berpori yang memungkinkan 

aliran rembesan dari cairan yang berupa air 

mengalir lewat rongga pori. Semakin tinggi 

tingkat kepadatan tanah, maka semakin kecil nilai 

koefisien permeabilitas dan debit rembesan yang 

dihasilkan. Garis freatik sebagai garis batas 

kejenuhan pada struktur tubuh bendungan. Garis 

freatik akan memisahkan daerah yang mengalami 

rembesan dengan daerah yang tidak mengalami 

rembesan. 

 

2.1.2.2. Waktu Pengosongan Tangki 

Pengosongan tangki, tangki disini 

diibaratkan dengan suatu waduk yang pada saat 

kondisi tertentu waduk tidak dapat suplai air 
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(inflow) sedangkan air di waduk terus 

dimanfaatkan (outfow) ini seperti diibaratkan 

dalam keadaan surut cepat. Untuk mengetahui 

durasi berapa lama waktu pengosongan dari 

kondisi air normal (MAN) sampai muka air 

rendah setinggi bibir intake dengan rumus 

(Hidraulika I, 2012): 

𝑡 =
2𝐴𝐻1

𝐶𝑑𝛼 2𝑔

1/2

 

Dimana, 

t = waktu pengosongan (det) 

A = luas tampungan (m
2
) 

H = beda tinggi (m) 

Cd = koefisien debit  

α = luas lubang/intake (m
2
) 

g = percepatan gravitasi (9,8m/det
2
) 

 

2.1.2.3. Pengaplikasian Software GeoStudio GEO 

SEEP 

 

GeoStudio adalah rangkaian produk 

perangkat lunak dari Geo-Slope International Ltd. 

yang dapat digunakanuntuk mengevaluasi kinerja 

bendungan atau tanggul dengan berbagai tingkat 

kompleksitas. SEEP/W adalah salah satu elemen 

dari produk GeoStudio dengan basic CAD 

terbatas untuk menganalisis rembesan air dan 

masalahdisipasi tekanan air pori berlebih dalam 

bahan berpori seperti tanah dan batuan. Formulasi 

yang komprehensif memungkinkan dapat 

mempertimbangkan analisis mulai dari yang 

sederhana, masalah kondisi jenuh steady-

statesampai dengan masalah kondisi jenuh atau 

tidak jenuh yang tergantung pada waktu. SEEP/W 

dapat diterapkanpada analisis dan desain untuk 
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geoteknik, sipil, hidrogeologi, dan kegiatan 

rekayasa pertambangan.(Anonim, 2007) 

Software perhitungan stabilitas 

bendungan sangatlah penting karena tanpa adanya 

software tersebut, diperlukan perhitungan banyak 

yang tidak dapat dihitung sekaligus menggunakan 

software perhitungan biasa seperti Microsoft 

Excel. Dengan adanya software ini dapat 

menghemat waktu dan mengefisiensikannya. 

Berikut contoh tata cara mengaplikasikan 

perhitungan kedalam software GeoStudio 

(SEEP/W) : 

 

I. Buka aplikasi GeoStudio 2012 

 

Gambar 2.1 Halaman Awal GeoStudio 2012 
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II. Membuat New Project 

a. Klik New Project untuk membuat 

new project 

 
Gambar 2.2 Letak New Project 

 

 

b. Pilih Create from Factory 

Defaults – International System 

of Units (SI), lalu klik create. 

 
Gambar 2.3 New Project 
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c. Ketik nama project di kolom Title 

 
Gambar 2.4 Tampilan New Project 

 

d. Klik add, pilih SEEP/W Analysis, 

pilih Steady-State, lalu klik close 

 
Gambar 2.5 Pilihan Analysis 

 

e. Menyimpan file 

1. Klik File, lalu klik Save As 

 
Gambar 2.6 Tampilan Save As 
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2. Ketik nama file, lalu klik Save 

 
Gambar 2.7 Tampilan Window Save 

 

III. Atur ukuran lembar kerja 

a. Klik Set, lalu klik Page 

 
Gambar 2.8 Tampilan  Lembar 

Kerja GeoStudio 

 

b. Atur lebar dan panjang lembar 

kerja beserta satuannya/units 

 
Gambar 2.9 Tampilan Set Page 
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IV. Membuat garis ukur, sumbu x dan y 

a. Klik Sketch, lalu klik Axes 

 
Gambar 2.10 Letak Axes 

 

b. Beri keterangan sumbu x dan y serta 

isi batasan minimal dan maksimal 

nilai di tiap-tiap sumbu, sesuaikan 

dengan gambar. 

 
Gambar 2.11 Tampilan Sketch 

Axes 
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V. Buka aplikasi Autocad 

 
Gambar 2.12 Desain pada AutoCad 

a. Ketik ID untuk mencari koordinat 

disetiap garis perpotongan 

 

b. Pilih satu titik yang saling berpotongan, 

lalu tekan enter, setelah itu 

masukankoordinat tersebut kedalam 

GeoStudio 

 
Gambar 2.13 Letak Koordinat 

 

VI. Membuat sketch gambar 

a. Klik Draw, lalu klik Point, atau 

masukkan melalui KeyIn lalu points 

lalu masukkan satu persatu 

koordinat titik yang berpotongan. 
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Gambar 2.14 cara memasukkan 

koordinat 

 

 

b. Klik satu titik pada lembar kerja, 

lalu input data koordinat x dan y dari 

bantuan Autocad 

 
Gambar 2.15 Pemasukkan 

Koordinat 
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VII. Untuk menghapus titik yang 

diinginkan 

a. Klik Modify, lalu klik Objects 

 
Gambar 2.16 Letak Object 

 

b. Klik titik yang ingin ingin di hapus, 

lalu klik delete, dan klik done 

 
Gambar 2.17 Setelah dihapus 

 

 

VIII. Menyambungkan antar titik dengan 

garis 

a. Klik Draw, lalu klik Regions 

b. Klik Polygon pada Domain Region, 

lalu tarik garis antar titik dengan 

sistem polygon tertutup 
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Gambar 2.18 Setelah Titik Koordinat 

Tersambung 

 

IX. Menginput material 

a. Klik Draw, lalu klik Materials 

 
Gambar 2.19 Letak Meterials 

 

b. Klik KeyIn 

 

 

 

 

 

 

  

Gambar 2.20 KeyIn Materials 

 

c. Klik Add untuk membuat material 
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Gambar 2.21 Add Materials 

 

d. Ketik nama material di kolom nama 

dan pilih jenis model material 

 
Gambar 2.22 Nama Material 

 

e. Klik […] pada Hyd. Conductivity 

Fn 
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Gambar 2.23 Pemasukan variabel 

material 

 

f. Klik Add 

 

 
Gambar 2.24 Pemasukan konduktivitas 

 

g. Ketik nama material di kolom 

material dan pilih tipe data material 

yang akan diinput 
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Gambar 2.25 Pilih tipe data 

material 

 

h. Klik Data Edit Points, lalu klik 

Estimate… 

 

 
Gambar 2.26 Penggantian Titik 

 

i. Pilih Metode estimasi yang akan 

digunakan dan isi data saturated  Kx 

sesuai hasil laboratorium mekanika 

tanah, lalu klik […] 
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Gambar 2.27 Metode Estimasi 

 

j. Untuk penambahan variabel Vol. 

Water Content sama dengan 

penambahan Hyd. Conductivity, 

Klik Add 

 

 
 Gambar 2.28 Add Vol. Water Content 
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k. Ketik nama material di kolom 

material dan pilih tipe data material 

yang akan diinput 

 

 
   Gambar 2.29 Penambahan Nama 

Material 

 

 

l. Klik Data Edit Points, lalu klik 

Estimate… 

 

 
Gambar 2.30 Penggantian Titik 
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m. Pilih Metode estimasi yang akan 

digunakan 

 

 
Gambar 2.31 Pemilihan metode 

estimasi 

 

n. Isi data saturated WC, Diameter 

saringan, dan liquid limit sesuai 

hasil laboratorium mekanika tanah, 

lalu klik OK. 

 
Gambar 2.32 Pengisian Variabel 
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o. Kembali pada Estimate Hydraulic 

Conductivity Function, Klik Vol. 

Water Content Fn., lalu input 

dengan material yang telah diisi 

sebelumnya, lalu klik OK 

 

 
  Gambar 2.33 Pengisian 

Variabel 2 

 

p. Kembali pada KeyIn Materials, Klik 

Hyd. Conductivity Fn., lalu input 

dengan material yang telah diisi 

sebelumnya 

 

 
Gambar 2.34 Penginputan 

Material sebelumnya. 
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q. Input rotation (sudut geser) dari 

hasil laboratorium mekanika tanah 

    
Gambar 2.35 Penginputan Sudut 

Geser 

 

r. Klik Vol. Water Content Fn., lalu 

input dengan material yang telah 

diisi sebelumnya 

 
Gambar 2.36 Penginputan Jenis Vol. 

Water Content yang di-input 

sebelumnya. 
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s. Klik Add untuk menginput material 

baru, lalu ketik nama material di 

kolom nama 

 
Gambar 2.37 Penambahan Material Baru. 

 

t. Pilih jenis model material 

 
Gambar 2.38 Pemilihan Jenis Material 
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u. Input data Saturated X-Conductivity 

dan rotation, lalu klik Close 

 

 
Gambar 2.39 Penginputan Data. 

 

v. Pilih jenis material lalu klik pada 

gambar sesuai jenis materialnya 

 
Gambar 2.40 Peng-input-an Material pada 

gambar. 
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X. Membuat Boundary Conditions atau 

pengelokasian titik yang terkena air. 

a. Klik Draw, lalu klik Boundary 

Conditions 

 
Gambar 2.41 Letak Boundary Conditions 

option. 

 

b. Klik KeyIn 

 

 

 

 

Gambar 2.42 pemasukan jenis Boundary. 

 

c. Klik Add, lalu klik Clone 

 
Gambar 2.43 Peng-clone-an jenis 

Boundary. 
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d. Ketik kondisi pada kolom nama dan 

tentukan jenis typenya 

 

 
Gambar 2.44 Pemilihan Tipe Boundary. 

 

e. Buka aplikasi Autocad, cari 

koordinat sumbu y pada kondisi 

yang dibuat 

 

 
Gambar 2.45 Pencarian koordinat-y. 
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f. Input koordinat sumbu y pada kolom 

action, lalu close. 

 

 
Gambar 2.46 Peng-input-an sumbu y. 

 

g. Klik salah satu kondisi, lalu klik 

garis pada gambar sesuai dengan 

masing-masing kondisi. 

 Zero Pressure 

 

 
Gambar 2.47 jenis Zero Pressure. 
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 Potential Seepage Face 

 

 
Gambar 2.48 Jenis Potential Seepage Face. 

 Muka Air Banjir (MAB) 

 

 
Gambar 2.49 Jenis MAB. 

 

XI. Membuat Flux atau garis yang ingin 

diketahui jumlah rembesan nya. 

a. Klik Draw, lalu klik Flux Sections 

 
Gambar 2.50 Letak Flux Section 

option 
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b. Ketik Section number pada kolom 

Section Number 

 
Gambar 2.51 urutan Section. 

 

c. Tarik garis lurus vertikal pada titik 

perpotongan lereng hilir bendungan 

 

 
Gambar 2.52 Flux Section. 

 

XII. Running 

a. Klik Window, lalu klik Solve 

Manager 

 

 

 

 

 

 

 

 

Gambar 2.53 Solve Manager 
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b. Klik Start 

 

 
Gambar 2.54 Solve Manager 2 

 

XIII. Hasil Running yang telah dibuat 

 

 

 

 

Gambar 2.55 Hasil Perhitungan. 
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2.2. Karya Terdahulu 

 

2.2.1. Kajian Kestabilan Tubuh Waduk Rukoh 

Kecamatan Titieu Keumala Kabupaten Pidie 

Keamanan terhadap kelongsoran lereng 

waduk dan rembesan (seepage) merupakan 

persyaratan utama untuk kestabilan waduk. Oleh 

sebab itu pembangunan waduk diupayakan tidak 

terjadi rembesan yang melewati batas rembesan 

yang diizinkan. Bila rembesan yang berlebihan 

ini tidak diantisipasi dapat menyebabkan 

perubahan tegangan efektif pada massa tanah 

itu, sehingga akan terjadi tekanan rembesan 

(seepage force) yang menyebabkan lepasnya 

ikatan antar partikel tanah dan terbentuknya 

deformasi yang permanen pada tubuh waduk, 

maka dikhawatirkan dapat terjadi kelongsoran 

dan/atau keruntuhan waduk yang akan 

menimbulkan kerugian. Kajian kestabilan 

waduk bertujuan untuk mendapatkan suatu 

kondisi kestabilan tubuh waduk yang memenuhi 

persyaratan aman pada waduk tersebut, baik 

aman terhadap kegagalan struktur maupun 

terhadap aliran rembesan. Hasil kajian 

kestabilan lereng waduk dan seepage masih di 

bawah faktor keamanan yang diizinkan pada 

sebuah waduk, maka waduk tersebut aman 

terhadap longsor dan seepage yang terjadi. 

Faktor keamanan yang diperoleh 1,2, dengan 

demikian waduk aman kestabilannya pada 

kondisi selesai konstruksi, kondisi muka air 

banjir, dan kondisi rapid drawdown. Sedangkan 

hasil debit rembesan yang terjadi pada kondisi 

muka air banjir 8,464x10-8 m3/sec/m’lebar 

waduk dan kondisi muka air normal 7,327x10-8 

m3/sec/m’lebar waduk. Hasil ini dapat dijadikan 
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bagian informasi keamanan kestabilan Waduk 

Rukoh. 

 

 

 

 

 

 

 

Gambar 2.56 Hasil Perhitungan dengan 

Geo(SEEP/W) 

 

Hasil perhitungan program GEO-

SLOOPE (SEEP/W) untuk menganalisis seepage 

yang terjadi menunjukkan bahwa sebagian besar 

perubahan garis gradien hidrolik terjadi pada 

daerah disekitar zona inti (kedap air), karena 

zona inti mempunyai koefisien rembesan lebih 

kecil dari zona lain. Perubahan-perubahan pada 

tinggi energi antara garis-garis ekipotensial 

menunjukkan juga bahwa air mengalir pada dua 

zona yaitu zona jenuh (saturated zone)dan zona 

tidak jenuh (unsaturated zone). Batas antara 

zona jenuh dan tidak jenuh adalah pada garis 

freatik (phreatic line) yang ditunjukkan oleh 

garis berwarna biru pada gambar. 

 

2.2.2. Pengaruh Fluktuasi Muka Air Waduk 

Terhadap Debit Rembesan Menggunakan 

Model SEEP/W (Studi Kasus di Bendungan 

Benel, Kabupaten Jembrana, Bali) 

Metode yang digunakan untuk 

mengetahui pengaruh fluktuasi muka air waduk 

terhadap debit rembesandilakukan pendekatan 

dengan menghitung lama durasi rembesan yang 

terjadi. Hasil dari model menunjukkan pola 

aliransesuai dengan prinsip metode 
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Cassagrande. Hasil perhitungan menunjukkan 

pengaruh fluktuasi muka air waduk sangat 

kecilterhadap debit rembesan dengan durasi 

rembesan mencapai rata-rata 2,5 tahun. Akan 

tetapi, rembesan yang terjadi setelahpengisian 

awal waduk hanya sekitar 5 bulan. Perbedaan 

durasi rembesan dari hasil perhitungan dan 

penelitian menunjukkan pemodelan belum 

sempurna. 

 

 

 

 

 

 

 

 

 

 

Gambar 2.57 Hubungan Elevasi MAW dengan 

Debit Rembesan 

 

 

 

 

 

 

 

 

 

 

Gambar 2.58 Hubungan Elevasi MAW dengan 

Panjang Lintasan Rembesan 
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Gambar 2.59 Hubungan Elevasi MAW dengan 

Durasi Rembesan 
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“Halaman ini sengaja dikosongkan” 
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BAB III METODOLOGI 

 

Penelitian ini akan menggunakan 4 permodelan 

(situasi) bendungan Tugu Kabupaten Trenggalek untuk 2 

jenis potongan bendungan yaitu potongan terbesar dan 

terkecil, permodelan yang menjadi acuan pada penelitian 

ini yaitu : 

1. Elevasi Muka Air Banjir, 

2. Elevasi setinggi Mercu Bendungan, 

3. Terjadi penurunan elevasi secara tiba-tiba, 

(Mercu sampai setinggi intake) 

4. Dead Storage, sedimen menutup saluran 

Intake. 

 

Yang akan diamati dari masing-masing 

permodelan diatas adalah  

1. Debit rembesan, 

2. Pola rembesan, 

3. Kecepatan rembesan, 

4. Batas kritis diameter butir yang diijinkan, 

5. Safety of factor kestabilan bendungan. 

 

Masing-masing permodelan akan diterapkan pada 

potongan melintang dari bendungan terbesar dan terkecil, 

dan hasil dari penelitian akan berupa desain akhir 

software.  

 

3.1. Skenario Permodelan 

3.1.1. Elevasi MAB (Muka Air Banjir) 

Elevasi MAB adalah elevasi tambahan 

yang teradi akibat debit banjir yang melebihi 

kapasitas Spillway. Elevasi berdasarkan data 

yang didapatkan menunjukkan elevasi 

mencapai +256,65. 

3.1.2. Elevasi Mercu Spillway (MAN) 

Elevasi yang terjadi saat debit sungai 

tidak melebihi elevasi mercu spillway, elevasi 
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air tergolong tinggi akan tetapi spillway 

kosong, yaitu pada elevasi +252,2. 

3.1.3. Surut Cepat 

Pada saat rembesan yang terjadi belum 

sempat turun dikarenakan perubahan debit 

sungai yang secara tiba-tiba, dimana rembesan 

berada pada elevasi yang jauh melebihi elevasi 

muka air sungai. Elevasi rembesan berada pada 

elevasi mercu spillway, sedangkan muka air asli 

berada pada elevasi mercu intake yaitu 

+215,50. Untuk potongan terkecil bendungan 

juga dihitung dengan perlakuan sama yaitu 

kosong. 

3.1.4. Dead Storage 

Sedimen akan sangat mempengaruhi 

kestabilan bendungan, pada permodelan kali ini 

sedimen akan dianggap mencapai elevasi Intake 

yaitu +215,50. Untuk potongan bendungan 

terkecil tidak dihitung dikarenakan elevasi 

sedimen tidak mencapai elevasi dasar potongan 

terkecil bendungan. 
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Gambar 3.1. Diagram alir pengerjaan 
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Tabel 3.1 Pedoman Perhitungan 

 

Keterangan : 

1. Elevasi Muka Air Banjir (+256,65) 

2. Elevasi Mercu Spillway (+250,60) 

3. Elevasi Intake (+215,50) 

4. Elevasi Dasar Bendungan (+179,00) 

Model Desain 

Bendungan 

Debit 

Rembesan 

Pola 

Rembesan 

Kecepatan 

Rembesan dan 

Durasi Rembesan. 

Safety of Factor 

Kestabilan 

Lereng 

Batas Kritis Diameter 

Butir dan Kecepatan 

Kritis 

 

Potongan Melintang 
Terbesar Bendungan 

(St. 7) Tugu Kab. 

Trenggalek. 

Didapat 

langsung dari 

GeoStudio 

SEEP/W 

dengan tiga 

flux, yaitu : 

1. Peralihan 

material 

tanah (inti 

tegak dan 

filter), 

2. Paling 

kritis 

pada 

setiap 

material 

tanah. 

Pola 

rembesan 

didapat dari 

GeoStudio 

SEEP/W. 

Dihitung secara 

manual menggunakan 

hukum persamaan 

Darcy sama dengan 

debit akan dihitung 

kecepatan pada setiap 

material. 

Didapat dari 

GeoStudio 

SLOPE/W dengan 

rembesan 

diaplikasikan 

langsung dari 

SEEP/W 

Dihitung dengan 

menggunakan rumus 

Kecepatan rembesan kritis 

(Vc) (Vc>Vs) 

 

Vc =
wF

gW1


 

Vs = kecepatan rembesan 

 

Potongan Melintang 

Terkecil Bendungan 

(St. 17) Tugu 

Kabupaten 

Trenggalek. 



 
 

45 
 

3.2. Data Sungai 

 

3.2.1. Data Debit 

Tabel 3.2 Data Debit Probabilias Tahunan K. Keser 

No 
Debit Q Diurutkan 

Tahun m3/det Tahun P% m3/det 

1 1976 71.68 1998 2.86 252.38 

2 1977 53.2 2003 5.71 135.18 

3 1978 49.83 1996 8.57 115.27 

4 1979 41.38 1995 11.43 114.1 

5 1980 18.9 1976 14.29 71.68 

6 1981 28.08 2002 17.14 68.91 

7 1982 25.23 2008 20 59.56 

8 1983 29.19 1997 22.86 53.56 

9 1984 21.81 1977 25.71 53.2 

10 1985 13.83 1978 28.57 49.83 

11 1986 15.61 1979 31.43 41.38 

12 1987 14.87 1999 34.29 38.73 

13 1988 19.96 1992 37.14 38.34 

14 1989 29.76 1994 40 38 

15 1990 25.23 2000 42.86 30.82 

16 1991 28.85 1989 45.71 29.76 

17 1992 38.34 2004 48.57 29.73 

18 1993 23.46 1983 51.43 29.19 

19 1994 38 2001 54.29 29.07 

20 1995 114.1 1991 57.14 28.85 

21 1996 115.27 1981 60 28.08 

22 1997 53.56 2007 62.86 26.84 
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No 
Debit Q Diurutkan 

Tahun m3/det Tahun P% m3/det 

23 1998 252.38 2005 65.71 26.11 

24 1999 38.73 1982 68.57 25.23 

25 2000 30.82 1990 71.43 25.23 

26 2001 29.07 2006 74.29 24.32 

27 2002 68.91 1993 77.14 23.46 

28 2003 135.18 1984 80 21.81 

29 2004 29.73 2009 82.86 20.08 

30 2005 26.11 1988 85.71 19.96 

31 2006 24.32 1980 88.57 18.9 

32 2007 26.84 1986 91.43 15.61 

33 2008 59.56 1987 94.29 14.87 

34 2009 20.08 1985 97.14 13.83 

(Sumber: Data Teknis Bendungan Tugu 

Kab.Trenggalek) 
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3.3. Data Tanah 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.2 Tubuh Bendungan Tugu 

 

Bendungan urugan tipe inti tegak, 

dengan 6 jenis material berbeda yang masing-

masing memiliki sifat berbeda : 

1. Inti Kedap 

2. Filter Halus 

3. Filter Kasar 

4. Random Tanah 

5. Batu 

6. Rip-Rap 
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3.3.1. Tubuh Bendungan 

Tabel 3.3 Daftar Koefisien Tanah Penyusun 

Bendungan. 

Material 
K 

cm/dtk 

Inti Kedap < 2,1 x 10
-7

 

Filter Halus < 2.5 x 10
-3

 

Filter Kasar < 5.5 x 10
-2

 

Random Tanah < 7.21 x 10
-4

 

Batu Free Drain 

Rip-rap Free Drain 

(Sumber: Data Teknis Bendungan 

Tugu Kab.Trenggalek) 
 

3.3.2. Bentuk Pondasi 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.3 Desain Bendungan Tugu 

Kabupaten Trenggalek 
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3.3.3. Pondasi 

 

Tabel 3.4 Daftar Koefisien Tanah 

Pondasi Bendungan. 

Material 
K 

cm/dtk 

Pondasi Batuan 1,0 x 10
-4

 

Pondasi Batuan yang digrouting 1 x 10
-5

 

Pondasi Alluvial 5 x 10
-4

 

Pondasi Kollovial 1 x 10
-4

 

(Sumber: Data Teknis Bendungan Tugu 

Kab.Trenggalek) 
 

3.3.4. Operasi Waduk dan Elevasi Muka Air 

 

Dengan data operasi waduk dan elevasi muka air 

yang terjadi, nantinya dapat diolah untuk mengetahui 

perubahan elevasi muka air sehingga dapat diketahui 

pengaruh perubahannya terhadap rembesan yang 

terjadi. Tabel 3.5. menunjukkan perhitungan 

hubungan elevasi muka air dan debit Bendungan 

Tugu dengan metode perhitungan pengosongan tangki 

nantinya akan didapat durasi terjadinya permodelan 

surut cepat. 

Tabel 3.5 Perhitungan Hubungan Elevasi Muka 

Air dan Debit 

No. 
Elevasi 

(m) 

Tinggi 

(m) 

Luas 
Genangan 

(x10ᶾ m²) 

Volume 
Tampungan 

(x10ᶾ mᶾ) 

Volume 

Tampungan 

Komulatif 
(x10ᶾ mᶾ) 

0 179,00 - 1,08 - - 

1 180,00 1,00 2,09 1,59 1,59 

2 181,00 2,00 2,88 2,49 4,08 

3 182,00 3,00 4,25 3,57 7,65 
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No. 
Elevasi 

(m) 
Tinggi 

(m) 

Luas 

Genangan 

(x10ᶾ m²) 

Volume 

Tampungan 

(x10ᶾ mᶾ) 

Volume 

Tampungan 
Komulatif 

(x10ᶾ mᶾ) 

4 183,00 4,00 5,35 4,80 12,45 

5 184,00 5,00 6,13 5,74 18,19 

6 185,00 6,00 9,03 7,58 25,77 

7 186,00 7,00 10,44 9,74 35,51 

8 187,00 8,00 11,44 10,94 46,45 

9 188,00 9,00 12,97 12,20 58,65 

10 189,00 10,00 17,74 15,35 74,00 

11 190,00 11,00 21,13 19,44 93,44 

12 191,00 12,00 24,38 22,76 116,20 

13 192,00 13,00 27,73 26,05 142,25 

14 193,00 14,00 30,88 29,30 171,55 

15 194,00 15,00 33,10 31,98 203,53 

16 195,00 16,00 35,81 34,45 237,98 

17 196,00 17,00 38,76 37,29 275,27 

18 197,00 18,00 42,61 40,69 315,96 

19 198,00 19,00 45,71 44,16 360,12 

20 199,00 20,00 48,49 47,10 407,22 

21 200,00 21,00 51,36 49,93 457,15 

22 201,00 22,00 55,00 53,18 510,33 

23 202,00 23,00 57,69 56,34 566,67 

24 203,00 24,00 60,52 59,10 625,77 

25 204,00 25,00 63,01 61,77 687,54 

26 205,00 26,00 65,34 64,18 751,72 

27 206,00 27,00 68,57 66,95 818,67 

28 207,00 28,00 71,72 70,15 888,82 

29 208,00 29,00 74,66 73,19 962,01 

30 209,00 30,00 78,57 76,61 1.038,62 

31 210,00 31,00 82,69 80,62 1.119,24 

32 211,00 32,00 86,55 84,62 1.203,86 

33 212,00 33,00 89,15 87,85 1.291,71 

34 213,00 34,00 92,79 90,97 1.382,68 

35 214,00 35,00 96,06 94,42 1.477,10 

36 215,00 36,00 100,75 98,40 1.575,50 

37 216,00 37,00 106,11 103,43 1.678,93 

38 217,00 38,00 110,30 108,21 1.787,14 

39 218,00 39,00 114,79 112,54 1.899,68 

40 219,00 40,00 120,11 117,45 2.017,13 

41 220,00 41,00 126,03 123,07 2.140,20 

42 221,00 42,00 131,61 128,82 2.269,02 

43 222,00 43,00 136,28 133,95 2.402,97 

44 223,00 44,00 140,96 138,62 2.541,59 

45 224,00 45,00 146,77 143,86 2.685,45 
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No. 
Elevasi 

(m) 
Tinggi 

(m) 

Luas 

Genangan 

(x10ᶾ m²) 

Volume 

Tampungan 

(x10ᶾ mᶾ) 

Volume 

Tampungan 
Komulatif 

(x10ᶾ mᶾ) 

46 225,00 46,00 155,69 151,23 2.836,68 

47 226,00 47,00 162,29 158,99 2.995,67 

48 227,00 48,00 167,11 164,70 3.160,37 

49 228,00 49,00 172,14 169,62 3.329,99 

50 229,00 50,00 177,19 174,67 3.504,66 

51 230,00 51,00 191,01 184,10 3.688,76 

52 231,00 52,00 198,76 194,89 3.883,65 

53 232,00 53,00 204,92 201,84 4.085,49 

54 233,00 54,00 211,72 208,32 4.293,81 

55 234,00 55,00 218,46 215,09 4.508,90 

56 235,00 56,00 237,43 227,94 4.736,84 

57 236,00 57,00 243,19 240,31 4.977,15 

58 237,00 58,00 248,18 245,69 5.222,84 

59 238,00 59,00 253,03 250,61 5.473,45 

60 239,00 60,00 257,80 255,42 5.728,87 

61 240,00 61,00 267,86 262,83 5.991,70 

62 241,00 62,00 277,10 272,48 6.264,18 

63 242,00 63,00 284,13 280,62 6.544,80 

64 243,00 64,00 290,86 287,50 6.832,30 

65 244,00 65,00 297,87 294,37 7.126,67 

66 245,00 66,00 308,88 303,38 7.430,05 

67 246,00 67,00 318,46 313,67 7.743,72 

68 247,00 68,00 326,84 322,64 8.066,36 

69 248,00 69,00 334,82 330,83 8.397,19 

70 249,00 70,00 342,85 338,84 8.736,03 

71 250,00 71,00 354,68 348,76 9.084,79 

72 251,00 72,00 365,37 360,02 9.444,81 

73 252,00 73,00 373,89 369,63 9.814,44 

74 253,00 74,00 382,35 378,12 10.192,56 

75 254,00 75,00 390,60 386,48 10.579,04 

76 255,00 76,00 401,15 395,88 10.974,92 

77 256,00 77,00 412,52 406,84 11.381,76 

78 257,00 78,00 420,85 416,69 11.798,45 

79 258,00 79,00 428,83 424,84 12.223,29 

80 259,00 80,00 436,55 432,69 12.655,98 

81 260,00 81,00 447,45 442,00 13.097,98 

82 261,00 82,00 456,03 451,74 13.549,72 

83 262,00 83,00 463,14 459,59 14.009,31 

(Sumber: Data Teknis Bendungan Tugu 

Trenggalek) 
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Gambar 3.5 Kurva Kapasitas Tampungan dan 

Luas Bendungan Tugu 
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BAB IV PERHITUNGAN 

 

4.1. Langkah Pengerjaan 

4.1.1. Pengumpulan Data 

4.1.1.1. Data Gambar Bendungan  

 Gambar Potongan Bendungan per stasiun  

 Gambar Peta Situasi  

 Gambar Peta Lokasi Titik Bor  

4.1.1.2. Data Tanah 

 Borlog Tanah Pondasi  

 Borlog Tanah Penyusun Bendungan  

4.1.1.3. Data Air 

4.1.2. Pembuatan Gambar Tanah Pondasi 

Untuk membentuk perkiraan susunan tanah 

pondasi, diperlukan borlog dan peta lokasi titik bor 

bidang yang diperlukan. 

 Bentuk garis dengan menyambungkan 

lokasi-lokasi bor (titik bor) yang ada 

sesuai dengan potongan bendungan yang 

dibutuhkan pada peta lokasi titik bor 

potongan bendungan yang dibutuhkan, 

Gambar 4.1 Lokasi titik bor As 

Bendungan Tugu 

 Dari garis yang terbentuk, gambar 

permukaan tanah sesuai peta kontur dari 

tanah yang dilewati garis tersebut, 



54  
 

 
 

Gambar 4.2 Permukaan Tanah 

 

 Kemudian plot borlog sesuai dengan peta 

kontur serta jarak yang terjadi pada garis 

yang terbentuk sebelumnya, 

Gambar 4.3 Diplot titik boring 

 

 Dari plot-an borlog yang terjadi 

perkirakan bentuk  tanah pondasi 

 dengan menyambungkan jenis tanah 

yang sama pada plot yang berdekatan. 

Gambar 4.4 Plot tanah pondasi berdasar 

hasil boring 

 Dan terbentuklah gambar perkiraan tanah 

pondasi. 
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Gambar 4.5 Gambar tanah pondasi 

 

4.1.3. Waktu Pengosongan Waduk untuk Kondisi 

Surut Cepat 

 

Kondisi Surut Cepat pengaplikasiannya pada 

saat dilapangan adalah pada saat dimana aliran yang 

masuk (inflow) kewaduk tidak ada, sedangkan 

penggunaan atau pemanfaatan air di waduk terus 

dilakukan (outflow). Keadaan ini sangat 

membahayakan karena air yang asalnya tinggi turun 

tiba-tiba dapat mengakibatkan air yang semula 

merembes kemudian turun dengan cepat dapat 

mempengaruhi ketahanan tubuh bendungan terhadap 

bahaya longsoran khususnya pada bagian hulu 

bendungan.  

Karena berdasarkan bahaya itulah waktu surut 

cepat harus diperhitungkan, waktu yang diperlukan 

untuk pengosongan waduk dari kondisi MAN menuju 

kondisi muka air rendah setinggi bibir intake dapat 

dihitung dari tabel kapasitas tampungan waduk seperti 

pada tabel 3.4, untuk perhitungan durasi surut cepat 

dihitung dari elevasi bibir intake sampai elevasi mercu 

spillway (+215,5 sampai +252,2). Dapat dihitung 

dengan rumus: 

 

𝑡 =
2𝐴𝐻1

𝐶𝑑𝛼 2𝑔

1/2

 

 

Misal perhitungan tiap 1m pada elevasi (+215 

sampai +216) 
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Dimana, 

A = 100,75(x10ᶾ m²) = 100.750 m² (pada elevasi 

+215) 

 = 106,11(x10ᶾ m²) = 106.110 m² (pada elevasi 

+216) 

H = 216-215 =1m 

Cd = 0,62 (Hidraulika I, 2012) 

𝛼  = 1,5m*1,5m 

  = 2,25m
2
 (luas lubang intake) 

g  = 9,8m/det
2 

 

Sehingga, 

𝑡 =
2𝐴𝐻1

𝐶𝑑𝛼 2𝑔

1/2

 

 

𝑡 =
2 ∗

100,75 m²+106,11 m²

2
∗ 1𝑚

0,62 ∗ 2,25m² 2 ∗ 9,8m/det2

1/2

 

𝑡 = 2.770,68𝑑𝑒𝑡 

Kemudian setelah dihitung tiap elevasi sampai 

elevasi mercu spillway, lamanya durasi surut cepat 

adalah sebesar 1,95hari atau sebesar 46,77 jam.  

Untuk menginputkan waktu tersebut ke dalam 

permodelan pada GeoStudio hampir sama dengan 

membuat analisis remebsan seperti biasa sebagaimana 

pada gambar 4.6 dan 4.7 akan tetapi pada pilihan 

Analisys type pilih transient kemudian pada pilihan 

parent masukkan keadaan awal rembesan atau pada 

kali ini keadaan MAN yang sudah dihitung 

sebelumnya, lalu pada bar Time dimasukkan waktu 

perubahan yang juga sudah dihitung sebelumnya. 
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4.1.4. Perbandingan Perhitungan manual dan 

menggunakan GeoStudio SEEP/W 

Penentuan garis depresi menggunakan 

perhitungan manual, dihitung menggunakan referensi 

2 perhitungan formasi garis depresi ada pada buku 

Bendungan Type Urugan editor Ir. Suyono 

Sosrodarsono dan Kensaku Takeda. 

Penulis mencoba membandingkan 

perhitungan yang ada pada contoh pada referensi 

tersebut dengan perhitungan menggunakan software 

GeoStudio SEEP/W. Dengan desain bendungan inti 

tegak serta hasil perhitungan manual sebagai berikut. 

 
Gambar 4.5. Desain Bendungan Manual  

Serta berikut adalah hasil perhitungan 

menggunakan GeoStudio SEEP/W dengan desain dan 

parameter perhitungan yang sama. 

 

Gambar 4.6. Hasil Perhitungan Software 

(Perbandingan) 

Terlihat formasi rembesan tidak jauh berbeda 

dengan perhitungan manual. Serta perhitungan debit 
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yang dihasilkan juga tidak terlalu berbeda. Berikut 

perhitungan debit manual : 

Memperkirakan besarnya kapasitas 

filtrasi yang mengalir melalui tubuh dan pondasi 

bendungan yang didasarkan pada jaringan 

trayektori aliran filtrasi, 

𝑄𝑓 =  
𝑁𝑓

𝑁𝑝
. 𝐾. 𝐻. 𝐿 

Dimana  

Qf  = kapasitas aliran filtrasi (kapasitas 

rembesan). 

Nf  = angka pembagi dari garis trayektori 

aliran filtrasi 

Np  = angka pembagi dari garis equi-

potensial 

K    = koefisien filtrasi 

H  = tinggi tekanan air total 

L   = panjang profil melintang tubuh 

bendungan 

 

Dengan menyesuaikan perhitungan yang ada 

pada GeoStudio SEEP/W yang membagi garis equi-

potensial sebanyak 15 maka perhitungan manual juga 

menggunakan angka tersebut. Serta jumlah pembagi 

garis trayektori yang tidak dibagi pada GeoStudio 

sehingga digunakan angka 1. Sedangkan untuk 

menentukan nilai k yang berbeda antara material k1 

dan k2, diperlukan k ekivalensi dengan rumus sebagai 

berikut : 

𝑘𝑧 =  
𝐿

𝑙1

𝑘1
+

𝑙2

𝑘2
+ 𝑑𝑠𝑡. .

 

Dimana   

kz  = koefisien ekivalensi 

l1  = panjang profil memanjang material 1 

l2  = panjang profil memanjang material 1 

K1    = koefisien material 1 
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K2  = koefisien material 2 

L   = panjang profil memanjang tubuh 

bendungan 

 

Sehingga didapat : 

𝑘𝑧 =
(60 + 24 + 52)

60

1,8𝐸−6
+

24

0,9𝐸−7
+

52

1,8𝐸−6

 

𝑘𝑧 =  
136

328888888,9
 

𝑘𝑧 = 4,13514𝐸 − 7 
𝑘𝑧 = 4,1351 𝑥 10−7𝑚/𝑑𝑒𝑡𝑖𝑘 

 

Selanjutnya perhitungan debit : 

𝑄𝑓 =
𝑁𝑓

𝑁𝑝
𝐾. 𝐻. 𝐿 

𝑄𝑓 =  
1

15
(4,13514𝐸 − 7)(29)(136) 

𝑄𝑓 =  7,9945𝐸 − 7 

𝑄𝑓 = 7,994 𝑥 10−7𝑚3/𝑑𝑒𝑡𝑖𝑘 

 

Perhitungan debit secara manual 

menghasilkan debit yang tidak terlalu berbeda dengan 

menggunakan software GeoStudio yang menghasilkan 

7,4306 x10
-7

 m
3
/detik, memiliki perbedaan hasil hanya 

sebesar 7,048 % dibandingkan dengan hasil 

perhitungan manual.  

 

 
Gambar 4.7. Hasil  Perhitungan Debit menggunakan 

Software GeoStudio 
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4.1.5. Perhitungan Rembesan 

Perhitungan rembesan menggunakan aplikasi 

GeoStudio 2007 

 Tata cara penggunaan aplikasi Geo 

Studio SEEP/W 2007 

1. Menggunakan aplikasi Geo Studio 

a. Buka aplikasi GeoStudio 

 
 

 

 

 

 

 

 

 

 

 

 

Gambar 4.6 Tampilan awal Geo 

Studio 

2. Membuat project baru 

a. Klik New, kemudian klik 

SEEP/W untuk memodelkan 

rembesan 

 

 

 

 

 

Gambar 4.7 Pilihan menu New 
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b. Ketik nama project di kolom 

title, kemudian pilih Steady-

State, lalu tutup untuk memulai. 

 
 

 

 

 

 

 

 

 

 

 

Gambar 4.8 Tampilan project di kolom 

title 

  

3. Mengatur  lembar kerja 

a. Atur panjang dan lebar lembar 

kerja klik Set> Page 

 

 

 

 

 

 

Gambar 4.9 Tampilan set page 

 

b. Atur sumbu x dan y isi batasan 

maksimal dan minimal 

berdasarkan koordinat yang 
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didapat dari gambar teknik klik 

Set> Axes.. 

 

  

 

 

Gambar 4.10 Tampilan Set 

axis size 

 

4. Mencari koordinat gambar teknis 

dari aplikasi Auto Cad 

a. Klik “id”> enter > klik pada 

sumbu pertemuan yang 

diinginkan 

 

 

 

 

 

 

 

Gambar 4.11 Tampilan tubuh 

bendungan pada aplikasi Auto Cad 

 

b. Maka didapat koordinat dari 

perpotongan sumbu yang 

diinginkan 
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c. Kemudiaan koordinat tersebut 

digunakan untuk menggambar 

pada aplikasi GeoStudio 

d. Jangan lupa tinggi muka air 

yang ditinjau juga dicari 

koordinatnya 

 

 

 

 

 

 

Gambar 4.12 Tampilan koordinat 

yang digunakan 

 

5. Masukkan koordinat pada aplikasi 

GeoStudio 

a. Klik Draw> Points, kemudian 

klik sembarang pada lembar 

kerja 

 

 

 

 

 

Gambar 4.13 Tampilan menu 

Draw 
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b. Untuk menyesuaikan koordinat, 

klik KeyIn> Points, kemudian 

ganti koordinat dengan 

koordinat yang sudah didapat 

dari AutoCad 

 

 

 

 

 

 

Gambar 4.14 Tampilan menu point 

 

 

c. Kemudian, masukkan semua 

koordinat yang telah kita dapat 

 

 

 

 

 

 

Gambar 4.15 Masukkan koordinat 
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d. Setelah itu semua titik sumbu 

koordinat sudah tergambar 

 

 

 

 

 

 

Gambar 4.16 Koordinat yang tergambar 

 

6. Gambar tubuh bendungan 

a. Hubungkan antar titik sumbu 

koordinat, klik Draw> Regions, 

kemudian hubungkan titik 

sumbu koordinat sesuai dengan 

gambar teknik 

b.  gambar teknik pada aplikasi 

AutoCad 

 

 

 

 

 

Gambar 4.17 Gambar region dari 

titik koordinat 
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c. Setelah semua sudah tergambar 

bentuk tubuh bendungan sudah 

terlihat 

 

 

 

 

 

Gambar 4.18 Tubuh bendungan 

yang tergambar 

 

7. Masukkan data material  

a. Klik KeyIn> Materials> add 

new material 

 

 

 

 

 

 

 

Gambar 4.19 Tampilan Keyin 

Material 
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b. Ketik nama material “Inti 

Kedap” 

 

 

 

 

 

 

Gambar 4.20 Masukkan Material 

 

c. Untuk jenis material timbunan 

menggunakan Saturated / 

Unsaturated, untuk tanah 

pondasi jenis materialnya 

menggunakan Saturated Only 

d. Masukkan data material yang 

tersedia 

e. Ratio, didapat dari data material 

(kh/kv) 

 

 

 

 

 

Gambar 4.21 Masukkan angka 

ratio tiap material 

f.  Klik […] pada Hyd. 

Coductivity Fn, lalu ganti 
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material (Inti Kedap), 

kemudian pilih Types: Data 

Point Function, setelah itu klik 

estimate 

 

 

 

 

 

 

Gambar 4.22 Tampilan Keyin 

Hydraulic Conductifity function 

g. Masukkan nilai koef. 

permeability dari inti kedap, 

untuk Estimation Method pilih 

Fredlund&Xing 

 

 

 

 

 

Gambar 4.23 Tampilan Estimate 

Hydraulic Conductivity Function 

h. Klik […] pada Hyd. 

Coductivity Fn, lalu ganti 

material (Inti Kedap), 

kemudian pilih Types: Data 
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Point Function, setelah itu klik 

estimate 

i. Estimation Method pilih 

Sample Functions, kemudian 

Saturated WC diisi data berat 

jenis kering permukaan 0.3 

m³/m³, Sample Material dipilih 

Clay 

 

 

 

 

 

Gambar 4.24 Tampilan Estimate 

Hydraulic Conductivity Function 

 

j. Setelah itu klik “Ok” 

k. Untuk data timbunan yang lain 

langkah-langkahnya sama 

seperti langkah-langkah “b-j” 

l. Untuk langkah “i”, Estimation 

Method pilih Grain-size data 

m. Jangan lupa data material tiap-

tiap timbunan berbeda, untuk 

itu berbeda juga entry 

materialnya, tergantung data 

yang tersedia. 

8. Menggambar material 

a. Klik Draw> Materials> pilih 

material yang ingin digambar 
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Gambar 4.25 Plot material sesuai 

desain 

 

b. Sampai tergambar semua 

material pada tubuh bendungan 

 

 

 

 

 

Gambar 4.26 Material telah 

tergambar 

 

9. Membuat boundary condition 

a. Klik KeyIn>Boundary 

Conditions> Add New 

Hydraulic BC (MAB), 

kemudian pilih type Head, lalu 
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isi pilihan Action dengan 

elevasi MAB pada koordinat 

yang telah diisi pada tahapan 

awal sebelumnya (1113.3 m) 

 

 

 

 

 

Gambar 4.27 Tampilan KeyIn 

Boundary Conditions 

b. Klik Draw, lalu klik Boundary 

Conditions 

 

 

 

 

 

 

 

 

 

 

Gambar 4.28 Gambar Boundary 

Conditions 
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o Zero Pressure 

 

 

 

 

 

 

 

 

Gambar 4.29 Tampilan Zero 

Pressure 

o Potential Seepage Face 

 

 

 

 

 

 

 

 

Gambar 4.30 Tampilan Potential 

Seepage 

o MAB (Tinggi Muka Air 

yang diinginkan) 

 

 

 

 

 

 

 

 

Gambar 4.31 Tampilan MAB 
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10. Membuat garis Flux Sections 

a. Klik Draw> Flux Sections 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.32 Gambar Flux Sections 

 

b. Isi section number 

 

 

 

 

 

 

 

Gambar 4.33 Tampilan Flux 

Sections 

 

c. Jika Flux section lebih dari 

satu, maka section number diisi 

dengan nomer yang berbeda, 

agar membedakan dengan yang 

awal 
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11. Running 

a. Klik Tools> Solve Analysis  

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.34 Tampilan Solve 

Analysis 

 

b. Atau klik pada menu Toolbar 

icon  

 

 

 

 

c. Kemudian klik Start 

 

 

 

 

 

 

 

 

 

Gambar 4.35 Tampilan Solve 

Analysis  
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12. Running telah dilakukan, garis 

depresi dapat dilihat 

a. Klik Window> Contour 

 

 

 

 

 

 

 

 

 

 

Gambar 4.36 Tampilan Contour 

 

b. Atau klik pada menu Toolbar 

icon 

 

 

c. Kemudian garis depresi akan 

tampil seperti berikut 

 

 

 

 

 

 

 

 

 

 

Gambar 4.37 Tampilan garis depresi 

 

d. Untuk SEEP/W kondisi yang 

lainnya, klik KeyIn> Analyses 
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e.  

 

 

 

 

 

 

 

 

 

Gambar 4.38 Tampilan KeyIn 

Analysis 

 

f. Kemudian klik Add> SEEP/W> 

Steady-State 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.39 Tampilan pilihan 

SEEP/W 

 

g. Untuk kondisi surut cepat 

Analysis Type diisi dengan 

Transient 
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Gambar 4.40 Tampilan pilihan 

SEEP/W-Transient 

 

h. Untuk langkah selanjutnya 

sama dengan langkah-langkah 

diatas. 

o Kondisi Muka Air 

Setinggi mercu 

Spillway(MAN) 

 

 

 

 

 

 

 

 

 

 

Gambar 4.41 Garis depresi 

kondisi MAN 

 

o Kondisi Muka Air 

Setinggi Sedimen 
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Gambar 4.42 Garis depresi kondisi 

setinggi sedimen 

 

o Kondisi Surut Cepat 

 

 

 

 

 

 

 

 

 

Gambar 4.43 Garis depresi 

kondisi surut cepat 

 

 Tata cara penggunaan aplikasi Geo 

Studio SLOPE/W 2007 

1. Membuat aplikasi longsoran 

(SLOPE/W) dari aplikasi SEEP/W 

yang telah dibuat 

a. Dari SEEP/W yang kita buat 

tadi, klik KeyIn> Analyses> 

Add> SLOPE/W pilih 

SIGMA/W Stress 
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Gambar 4.44 Pilihan SLOPE/W 

 

b. Isi Analysis Type dengan 

Bishop, Ordinary and Janbu 

c. Isi PWP Conditions from 

dengan Parent Analysis 

 

 

 

 

 

Gambar 4.45 Tampilan KeyIn 

Analysis 

 

d. Kemudian pilih menu Slip 

Surface, untuk Direction of 

movement pilih right to left 

(kelongsoran pada bagian hulu 

tubuh bendungan), lalu untuk 

Slip Surface Option pilih Entry 

and Exit, kemudian close. 
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Gambar 4.46 Tampilan Slip 

Surface 

 

2. Masukkan data material yang 

tersedia kemudian gambar 

a. Isi material klik KeyIn> 

Materials, kemudian isi dengan 

data material yang tersedia 
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Gambar 4.47 Tampilan KeyIn 

Materials 

  

b. Setelah semua material diisi, 

plot material/gambar material, 

klik Draw> Materials 

 

 

 

 

 

 

 

 

 

 

Gambar 4.48 Material yang 

tergambar 

 

3. Atur Slip Surface untuk mengatur 

kelongsoran  

a. Klik Draw> Slip Surface> 

Entry and Exit 

 

 

 

 

 

 

 

 

 

Gambar 4.49 Pilih Entry and Exit 
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b. Yang bagian kiri Type Point 

dan yang bagian kanan berupa 

Range 

 

 

 

 

 

 

 

 

 

Gambar 4.50 Gambar Entry and Exit 

 

c. Kemudian klik Apply> Done 

 

4. Running 

a. Klik Tools> Solve Analysis  

 

 

 

 

 

 

 

 

 

 

Gambar 4.51 Solve Analysis 

 

b. Atau klik pada menu Toolbar 

icon  

 

 

c. Kemudian klik Start 
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5. Running telah dilakukan, bentuk 

longsoran dapat dilihat 

a. Klik Window> Contour 

 

 

 

 

 

 

 

 

 

 

Gambar 4.52 Tampilan Contour 

 

b. Atau klik pada menu Toolbar 

icon 

 

 

c.  Kemudian bentuk longsoran 

akan tampil seperti berikut 

 

 

 

 

 

 

 

 

 

 

Gambar 4.53 Bentuk longsoran 

MAB 
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d. Untuk melihat angka Safety 

Factor dapat dilihat dengan cara 

klik icon  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.54 Tampilan Slip Surface 

 

e. Untuk SLOPE/W kondisi yang 

lainnya, sama dengan langkah 

1a-1d 

f. Untuk hasil bentuk longsoran 

sebagai berikut 
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o Kondisi Tinggi Muka Air 

setinggi Spillway 

Longsoran Hulu 

 

 

 

 

 

 

 

 

 

Gambar 4.55 Bentuk longsoran 

kondisi MAN 

 

o Kondisi Muka Air 

Setinggi Sedimen 

Longsoran Hulu 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.56 Bentuk longsoran 

kondisi MAN 
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o Kondisi Surut Cepat 

Longsoran Hulu 

 

 

 

 

 

 

 

 

 

 

Gambar 4.57 Bentuk longsoran 

kondisi Surut Cepat 

 

4.1.6. Analisis Rembesan 

Yang dianalisis dari penelitian kali ini adalah 

dampak rembesan terhadap longsor, gejala piping dan 

sembulan (sufosi dan boiling), panjang lintasan 

rembesan, pola rembesan, kecepatan rembesan dan 

debit rembesan. Semua permodelan akan dianalisis. 

 Panjang lintasan rembesan yang terjadi 

dari masing-masing permodelan, 

 Pola rembesan yang terjadi dari masing-

masing permodelan, 

 Kecepatan rembesan yang terjadi dari 

masing-masing permodelan, 

 Debit rembesan yang terjadi dari masing-

masing permodelan, 

 Perhitungan batas kritis diameter material 

yang terbawa menggunakan rumus batas 

kecepatan sebelum terjadi sembulan dan 

piping, 

 Pengecekan dampak rembesan terhadap 

longsoran masing-masing permodelan. 
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4.2. Hasil Perhitungan GeoStudio SEEP/W (Rembesan) 

Perhitungan didapat menggunakan software 

analisis rembesan air untuk menganalisis rembesan yang 

terjadi. Software yang digunakan untuk penelitian ini 

menggunakan GEO STUDIO SEEP/W. 

Perhitungan dibedakan pada setiap permodelan 

dan yang akan diamati pada penelitian kali ini adalah pola, 

debit, panjang lintasan dan kecepatan rembesan yang 

terjadi. 

4.2.1. Elevasi MAB (Muka Air Banjir) 

Rembesan yang terjadi pada permodelan kali 

ini mengalami naik-turun sementara pada bagian awal 

garis rembesan, yang selanjutnya langsung turun 

sebagaimana diperlihatkan pada gambar 4.58. 

 
Gambar 4.58 Pola rembesan saat turun melewati 

material inti 

 
Gambar 4.59 Pola  rembesan permodelan Elevasi 

MAB 

 

Garis rembesan seakan jatuh bebas pada saat 

melewati material inti, dengan kecepatan rembesan 

berkisar 5,2993 x10
-12

 sampai 3,25 x10
-9

 m/detik. 

Serta memiliki rembesan sebesar 2,5183 x10
-18 
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m
3
/detik. Sedangkan rembesan yang terjadi pada 

ujung hilir bendungan sebesar 8,595 x10
-4 

m
3
/detik 

dengan kecepatan berkisar 3,25551 x10
-6

 sampai 

1,63481 x10
-5

 m/detik. 

 

Tabel 4.1. Kecepatan Rembesan Tercepat Setiap 

Material Permodelan MAB 

Inti 
Filter 

Halus 

Filter 

Kasar 
Batu 

Random 

Tanah 
Rip-rap 

8,01x10-9 6,82x10-6 6,54x10-6 1,09x10-3 5,63x10-7 1,97x10-4 

(Sumber: Perhitungan) 

 

4.2.2. Elevasi Mercu Spillway 

Pola rembesan menunjukkan penurunan batas 

rembesan sebagaimana mestinya sebagaimana 

diperlihatkan pada gambar 4.60. Terjadinya 

penurunan drastis pada saat melewati material inti. 

 
Gambar 4.60 Pola rembesan permodelan Elevasi 

Mercu Spillway 

 

Seperti halnya pola rembesan pada 

permodelan MAB terjadi momen naik-turun pada 

awal garis rembesan, meskipun tidak sedrastis MAB, 

akan dikhawatirkan dapat mempengaruhi kestabilan 

lereng juga. 
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Gambar 4.61 Pola rembesan permodelan Mercu 

Spillway saat melewati material inti 

 

Debit yang terjadi pada permodelan kali ini 

menunjukkan angka sebesar 0,0041736 m
3
/detik pada 

ujung hilir bendungan, sedangkan pada peralihan inti 

tegak menuju filter halus memiliki angka rembesan 

sebesar 1,5584 x10
-7

 m
3
/detik. 

Sedangkan kecepatan rata-rata rembesan yang 

sejajar dengan flux section pada ujung hilir bendungan 

sumbu-xy berkisar antara 9,86606 x10
-6

 sampai 

3,76741 x10
-5 

m/detik. 

 

Tabel 4.2. Kecepatan Rembesan Tercepat Setiap 

Material Permodelan Mercu Spillway 

Inti 
Filter 

Halus 

Filter 

Kasar 
Batu 

Random 

Tanah 
Rip-rap 

2,20x10-9 1,38x10-6 1,26x10-5 1,73x10-3 6,28x10-7 7,98x10-4 

(Sumber: Perhitungan) 

 

4.2.3. Surut Cepat 

Permodelan ini dimodelkan seakan-akan debit 

sungai tiba-tiba berhenti seketika setelah terjadi 

elevasi air setinggi mercu spillway yaitu setinggi 

+256,65, dan disaat yang sama intake sedang 

berfungsi sehingga terjadi penurunan elevasi air 

sampai elevasi lubang intake (+215,50) atau turun 

sebanyak 35,10 m dalam durasi 168.354 detik (hasil 

perhitungan waktu pengosongan) atau 46,77 jam 

(kurang dari 2 hari). 



90  
 

 
 

Rembesan yang terjadi menunjukkan bahwa 

banyak air yang tertahan di material bagian inti. 

Sedangkan material lainnya tidak ada yang menahan 

air sebagaimana material inti kecuali sebagian kecil 

bagian material filter kasar dan halus. Sebagaimana 

terlihat di gambar 4.63. 

 
Gambar 4.62 Pola rembesan permodelan Surut 

Cepat 

 
Gambar 4.63 Pola rembesan permodelan Surut 

Cepat saat melewati material inti 

 

Kecepatan rembesan saat terjadinya turunan 

karena melewati material inti terjadi kisaran 3,8472 

x10
-10 

sampai 2,8849 x10
-9 

m/detik dengan debit 

sebesar 6,8289 x10
-8 

m
3
/detik. Sedangkan kecepatan 

turunnya rembesan di hulu akibat turunnya elevasi air 

secara tiba-tiba berkisar 2,69975 x10
-9

 sampai 

1,698332 x10
-5

 m/detik dengan debit sebesar 1,9363 

x10
-8 

m
3
/detik. Sedangkan kecepatan yang terjadi pada 

ujung hilir bendungan menghasilkan kecepatan antara 
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1,85674 x10
-6 

sampai 1,823034 x10
-5 

m/detik dengan 

debit rembesan sebesar 1,6762 x10
-4 

m
3
/detik. 

 

Tabel 4.3. Kecepatan Rembesan Tercepat Setiap 

Material Permodelan Surut Cepat 

Inti 
Filter 

Halus 

Filter 

Kasar 
Batu 

Random 

Tanah 
Rip-rap 

4,85x10-9 6,82x10-6 6,54x10-6 1,59x10-9 2,52x10-7 1,97x10-4 

(Sumber: Perhitungan) 

 

4.2.4. Dead Storage 

Permodelan ini dimaksudkan untuk 

mengetahui pengaruh rembesan pada tubuh 

bendungan saat sedimen sungai mencapai elevasi 

mercu intake atau setinggi +215,50. 

Permodelan ini memiliki rembesan yang 

sangat mirip dengan permodelan Spillway. Hal ini 

dikarenakan permodelan ini juga dimodelkan dengan 

elevasi yang sama dengan permodelan tersebut, 

sebagaimana terlihat pada gambar 4.64. 

 
Gambar 4.64 Pola rembesan permodelan Dead 

Storage 

 

Kecepatan rembesan pada penurunan saat 

melewati material inti juga berkisar 1,493557 x10
-11 

sampai 6,003989 x10
-9 

m/detik dengan debit sekitar 

1,561 x10
-7 

m
3
/detik. Sedangkan debit rembesan pada 

ujung hilir bendungan sebesar 0,0041765 m
3
/detik, 
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dengan kecepatan berkisar 9,87287 x10
-6 

sampai 

3,76996 x10
-5 

m/detik. 

 

Tabel 4.4. Kecepatan Rembesan Tercepat Setiap 

Material Permodelan Dead Storage 

Inti 
Filter 

Halus 

Filter 

Kasar 
Batu 

Random 

Tanah 
Rip-rap 

3,19x10-9 3,88x10-7 3,81x10-7 3,17x10-3 1,91x10-7 8,94x10-5 

(Sumber: Perhitungan) 

 

4.2.5. MAB Bendungan Potongan Kecil 

Pola rembesan yang ada permodelan ini, 

hampir tidak terjadi penurunan yang signifikan, 

berbeda dengan permodelan yang lainnya. 

Dikarenakan kecilnya potongan yang berisi material 

inti –yang memiliki nilai k tinggi– sehingga rembesan 

banyak yang melewati bendungan melalui tanah 

pondasi yang memiliki nilai k lebih besar, 

sebagaimana terlihat pada gambar 4.65. 

 
Gambar 4.65. Pola Rembesan Permodelan MAB 

Potongan Kecil. 

 

Pada gambar 4.65. terlihat hanya mengalami 

penurunan sekitar 3 m dari elevasi awal mulanya, 

sedangkan permodelan lain mengalami penurunan 

sekitar 80-90 m. Hal ini disebabkan karena 

permodelan ini hanya memiliki material inti yang 

paling berpengaruh hanya setinggi 14 m. Serta arah 

panah rembesan tidak ada yang terlihat melewati inti 

tegak dan lebih banyak terlihat pada tanah pondasi, 
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serta material batu dan pada sebagian filter kasar dan 

halus. 

 

Tabel 4.5. Kecepatan Rembesan Tercepat Setiap 

Material Permodelan MAB Bendungan Kecil. 

Inti 
Filter 

Halus 

Filter 

Kasar 
Batu Rip-rap 

6,96x10-10 6,46x10-6 3,31x10-5 8,1x10-5 1,77x10-5 

(Sumber: Perhitungan) 

 

4.3. Hasil Perhitungan GeoStudio SLOPE/W (Longsoran) 

Salah satu dampak dari rembesan di bendungan 

adalah pengaruhnya pada kestabilan lereng oleh karena itu 

penggunaan software kestabilan lereng atau pada analisis 

kali ini menggunakan GeoStudio SLOPE/W yang 

merupakan pasangan dari SEEP/W yang digunakan untuk 

menghitung rembesan sebelumnya menjadi semakin 

mudah pengaplikasiannya. 

Kestabilan lereng akan diperhitungkan keduanya 

baik hulu maupun hilir dan akan dihadirkan 5 safety of 

factor dari kestabilan lereng paling kritis dari setiap 

permodelan.  

 

4.3.1. Elevasi MAB (Muka Air Banjir) 

4.3.1.1. Hulu 

Longsoran pada hulu untuk permodelan 

elevasi MAB memiliki critical slip paling kecil 

sebesar 1,237 (safety of factor) dengan gambar 

critical sebagaimana berikut.  
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Gambar 4.65 Critical Slip permodelan 

MAB Hulu 

 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian hulu. 

 

Tabel 4.5 safety of factor pada bagian hulu 

Safety of Factor Gambar 

1,237 

 

 
Gambar 4.66 Critical Slip 

permodelan MAB Hulu 1 

1,413 

 
Gambar 4.67 Critical Slip 

permodelan MAB Hulu 2 

1,431 

 
Gambar 4.68 Critical Slip 

permodelan MAB Hulu 3 

1,560 

 
Gambar 4.69 Critical Slip 

permodelan MAB Hulu 4 
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Safety of Factor Gambar 

1,598 

 
Gambar 4.70 Critical Slip 

permodelan MAB Hulu 5 

(Sumber: Perhitungan) 

 

4.3.1.2. Hilir 

Longsoran pada hilir untuk permodelan 

elevasi MAB memiliki critical slip paling kecil 

sebesar 1,464 (safety of factor) dengan gambar 

critical sebagaimana berikut.  

 
Gambar 4.71 Critical Slip permodelan 

MAB Hilir 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian hilir. 

 

Tabel 4.6 safety of factor pada bagian hilir 

Safety of Factor Gambar 

1,464 

 
Gambar 4.72 Critical Slip 

permodelan MAB Hilir 1 
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Safety of Factor Gambar 

1,494 

 
Gambar 4.73 Critical Slip 

permodelan MAB Hilir 2 

1,512 

 
Gambar 4.74 Critical Slip 

permodelan MAB Hilir 3 

1,520 

 
Gambar 4.75 Critical Slip 

permodelan MAB Hilir 4 

1,521 

 
Gambar 4.76 Critical Slip 

permodelan MAB Hilir 5 

(Sumber: Perhitungan) 

 

4.3.2. Elevasi Mercu Spillway/MAN (Muka Air 

Normal 

4.3.2.1. Hulu 

Longsoran pada hulu untuk permodelan 

elevasi Mercu Spillway memiliki critical slip 

paling kecil sebesar 1,237 (safety of factor) 

dengan gambar critical sebagaimana berikut.  
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Gambar 4.77 Critical Slip permodelan Mercu 

Spillway Hulu 

 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian hulu. 

 

Tabel 4.7 safety of factor pada bagian hulu 

Safety of Factor Gambar 

1,237 

 
Gambar 4.78 Critical Slip 

permodelan Mercu Spillway Hulu 

1 

1,416 

 
Gambar 4.79 Critical Slip 

permodelan Mercu Spillway Hulu 

2 

1,431 

 
Gambar 4.80 Critical Slip 

permodelan Mercu Spillway Hulu 
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Safety of Factor Gambar 

3 

1,526 

 
Gambar 4.81 Critical Slip 

permodelan Mercu Spillway Hulu 

4 

1,561 

 
Gambar 4.82 Critical Slip 

permodelan Mercu Spillway Hulu 

5 

(Sumber: Perhitungan) 

 

 

 

4.3.2.2. Hilir 

Longsoran pada hilir untuk permodelan 

elevasi Mercu Spillway memiliki critical slip 

paling kecil sebesar 1,484 (safety of factor) 

dengan gambar critical sebagaimana berikut.  

 
Gambar 4.83 Critical Slip permodelan Mercu 

Spillway Hilir 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian hulu. 
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Tabel 4.8 safety of factor pada bagian hilir 

Safety of Factor Gambar 

1,484 

 
Gambar 4.84 Critical Slip 

permodelan Mercu Spillway Hilir 

1 

1,490 

 
Gambar 4.85 Critical Slip 

permodelan Mercu Spillway Hilir 

2 

1,508 

 
Gambar 4.86 Critical Slip 

permodelan Mercu Spillway Hilir 

3 

1,510 

 
Gambar 4.87 Critical Slip 

permodelan Mercu Spillway Hilir 

4 
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Safety of Factor Gambar 

1,520 

 
Gambar 4.88 Critical Slip 

permodelan Mercu Spillway Hilir 

5 

(Sumber: Perhitungan) 

 

4.3.3. Surut Cepat 

4.3.3.1. Hulu 

Longsoran pada hulu untuk permodelan 

Surut Cepat memiliki critical slip paling kecil 

sebesar 1,236 (safety of factor) dengan gambar 

critical sebagaimana berikut.  

 
Gambar 4.89 Critical Slip permodelan Surut 

Cepat Hulu 

 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian hulu. 

 

Tabel 4.9 safety of factor pada bagian hulu 

Safety of Factor Gambar 

1,236 

 
Gambar 4.90 Critical Slip 

permodelan Surut Cepat Hulu 1 
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Safety of Factor Gambar 

1,369 

 
Gambar 4.91 Critical Slip 

permodelan Surut Cepat Hulu 2 

1,373 

 
Gambar 4.92 Critical Slip 

permodelan Surut Cepat Hulu 3 

1,378 

 
Gambar 4.93 Critical Slip 

permodelan Surut Cepat Hulu 4 

1,395 

 
Gambar 4.94 Critical Slip 

permodelan Surut Cepat Hulu 5 

(Sumber: Perhitungan) 

 

4.3.3.2. Hilir 

Longsoran pada hilir untuk permodelan 

elevasi Surut Cepat memiliki critical slip paling 

kecil sebesar 1,487 (safety of factor) dengan 

gambar critical sebagaimana berikut.  
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Gambar 4.95 Critical Slip permodelan Surut 

Cepat Hilir 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian hulu. 

Tabel 4.10 safety of factor pada bagian hilir 

Safety of Factor Gambar 

1,487 

 
Gambar 4.96 Critical Slip 

permodelan Surut Cepat Hilir 1 

1,510 

 
Gambar 4.97 Critical Slip 

permodelan Surut Cepat Hilir 2 

1,512 

 
Gambar 4.98 Critical Slip 

permodelan Surut Cepat Hilir 3 

1,517 

 
Gambar 4.99 Critical Slip 

permodelan Surut Cepat Hilir 4 
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Safety of Factor Gambar 

1,529 

 
Gambar 4.100 Critical Slip 

permodelan Surut Cepat Hilir 5 

(Sumber: Perhitungan) 

 

4.3.4. Dead Storage 

4.3.4.1. Hulu 

Longsoran pada hulu untuk permodelan 

Dead Storage memiliki critical slip paling kecil 

sebesar 1,565 (safety of factor) dengan gambar 

critical sebagaimana berikut.  

 
Gambar 4.101 Critical Slip permodelan Dead 

Storage Hulu 

 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian hulu. 

 

Tabel 4.11 safety of factor pada bagian hulu 

Safety of Factor Gambar 

1,565 

 
Gambar 4.102 Critical Slip 

permodelan Dead Storage Hulu 1 
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Safety of Factor Gambar 

1,612 

 
Gambar 4.103 Critical Slip 

permodelan Dead Storage Hulu 2 

1,702 

 
Gambar 4.104 Critical Slip 

permodelan Dead Storage Hulu 3 

1,719 

 
Gambar 4.105 Critical Slip 

permodelan Dead Storage Hulu 4 

1,726 

 
Gambar 4.106 Critical Slip 

permodelan Dead Storage Hulu 5 

(Sumber: Perhitungan) 

 

4.3.4.2. Hilir 

Longsoran pada hilir untuk 

permodelan Dead Storage memiliki critical 

slip paling kecil sebesar 1,480 (safety of 

factor) dengan gambar critical sebagaimana 

berikut.  
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Gambar 4.107 Critical Slip permodelan Dead 

Storage Hilir 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian 

hulu. 

 

Tabel 4.12 safety of factor pada bagian hilir 

Safety of Factor Gambar 

1,480 

 
Gambar 4.108 Critical Slip 

permodelan Dead Storage Hilir 1 

1,490 

 
Gambar 4.109 Critical Slip 

permodelan Dead Storage Hilir 2 

1,520 

 
Gambar 4.110 Critical Slip 

permodelan Dead Storage Hilir 3 
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Safety of Factor Gambar 

1,526 

 
Gambar 4.111 Critical Slip 

permodelan Dead Storage Hilir 4 

1,561 

 
Gambar 4.112 Critical Slip 

permodelan Dead Storage Hilir 5 

(Sumber: Perhitungan) 

 

4.3.5. Potongan Bendungan Kecil 

4.3.5.1. Hulu 

Longsoran pada hulu untuk permodelan 

Potongan Bendungan Kecil memiliki critical slip 

paling kecil sebesar 1,860 (safety of factor) 

dengan gambar critical sebagaimana berikut.  

 

 
Gambar 4.113 Critical Slip permodelan Dead 

Storage Hulu 

 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian hulu. 
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Tabel 4.13 safety of factor pada bagian hulu 

Safety of Factor Gambar 

1,860 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hulu 1 

2,230 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hulu 2 

2,416 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hulu 3 
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Safety of Factor Gambar 

2,556 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hulu 4 

2,682 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hulu 4 

(Sumber: Perhitungan) 

 

4.3.5.2. Hilir 

Longsoran pada hilir untuk 

permodelan Potongan Bendungan Kecil 

memiliki critical slip paling kecil sebesar 

1,683 (safety of factor) dengan gambar critical 

sebagaimana berikut.  
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Gambar 4.107 Critical Slip permodelan Dead 

Storage Hilir 

Berikut tabel 5 safety of factor paling 

kritis dari permodelan kali ini pada bagian 

hulu. 

 

Tabel 4.14 safety of factor pada bagian hilir 

Safety of Factor Gambar 

1,683 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hilir 1 

1,683 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hilir 2 
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Safety of Factor Gambar 

1,683 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hilir 3 

1,777 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hilir 4 

1,777 

 
Gambar 4.102 Critical Slip 

permodelan Potongan Bendungan 

Kecil Hilir 5 

(Sumber: Perhitungan) 

 

 



111 
 

 
 

4.4. Perhitungan Batas Kritis Diameter Butir setiap 

Permodelan 

Untuk perhitungan batas kritis diameter butir 

dilakukan secara manual menggunakan rumus kecepatan 

yang diijinkan: 

Vc >Vs 

Vc =
wF

gW


1

.............................................(4.1)

 

dimana,  

Vc = Kecepatan rembesan kritis yang 

diijinkan. 

Vs = Kecepatan rembesan 

d = Diameter butiran terkecil  

W1 = (Gs - 1) x  
6

1
 x  x d

3
 

Gs = Gravity specific (berat jenis) 

g  = Gravitasi 

F  = luas penampang butiran terkecil 

γ  = Berat volume(gram/cm
3
) 

w  = water content (%)
 

 

 

 

𝑉𝑐 =  
𝑊1 .𝑔

𝐹.𝛾.𝑤
..............................(4.2) 

 

𝑉𝑐 =   
 𝐺𝑠−1 .

1

6
.𝜋.𝑑3 .𝑔

𝐹.𝛾.𝑤
................(4.3) 

 

𝑉𝑐
2 =  

 𝐺𝑠−1 .
1

6
.𝜋.𝑑3 .𝑔

𝐹.𝛾.𝑤
...................(4.4) 

 
𝑉𝑐

2 .6.𝐹.𝛾.𝑤

 𝐺𝑠−1 .𝜋.𝑔
=  𝑑3....................................(4.5) 



112  
 

 
 

 

 
𝑉𝑐

2 .6.
𝜋

4
.𝑑2 .𝛾 .𝑤

 𝐺𝑠−1 .𝜋.𝑔

3

=  𝑑.....................................(4.6) 

 

Dari rumus (4.1) akan dikonversikan menjadi 

rumus (4.6), batas kritis butiran akan dihitung pada tiap 

material dengan menggunakan kecepatan tertinggi (paling 

kritis) yang terdapat pada jenis material tersebut. Berikut 

hasil perhitungan pada setiap jenis material dan setiap 

permodelan. Berikut hasil perhitungan menggunakan 

software excel menggunakan rumus (4.6) sebagaimana 

pada tabel. 

 

Tabel 4.15 Hasil Perhitungan Diameter Kritis. 

 
(Sumber: Perhitungan) 

 

Permodelan Material Vc Gs Gs-1 γ(gr/cm) w d (m) d (cm)

MAB Batu 1,09E-03 2,680000 1,680000 22,40 0,041% 3,86E-07 3,86E-05

MAB Rip-Rap 1,97E-04 2,680000 1,680000 23,20 0,000% 5,77E-11 5,77E-09

MAB Filter Halus 6,82E-06 2,680000 1,680000 18,88 34,970% 1,08E-08 1,08E-06

MAB Filter Kasar 6,54E-06 2,680000 1,680000 19,87 27,900% 8,31E-09 8,31E-07

MAB Random Tanah 5,63E-07 2,750000 1,750000 19,50 0,005% 1,06E-14 1,06E-12

MAB Inti 1,49E-09 2,650000 1,650000 18,39 29,700% 4,32E-16 4,32E-14

MAB kecil Rip-Rap 1,77E-05 2,680000 1,680000 23,20 0,018% 1,44E-05 0,001441

MAB kecil Batu 8,06E-05 2,680000 1,680000 22,40 0,410% 1,81E-07 1,81E-05

MAB kecil Filter Kasar 3,31E-05 2,680000 1,680000 19,87 27,900% 1,37E-07 1,37E-05

MAB kecil Filter Halus 6,37E-06 2,680000 1,680000 18,88 34,970% 1,16E-08 1,16E-06

MAB kecil Inti 6,96E-10 2,650000 1,650000 18,39 29,999% 6,57E-11 6,57E-09

MAN Batu 1,73E-03 2,680000 1,680000 22,40 0,041% 9,58E-07 9,58E-05

MAN Rip-Rap 7,98E-04 2,680000 1,680000 23,20 0,000% 9,51E-10 9,51E-08

MAN Filter Kasar 1,26E-05 2,680000 1,680000 19,87 27,900% 3,08E-08 3,08E-06

MAN Filter Halus 1,38E-06 2,680000 1,680000 18,88 34,970% 4,41E-10 4,41E-08

MAN Random Tanah 6,28E-07 2,750000 1,750000 19,50 0,005% 1,32E-14 1,32E-12

MAN Inti 2,20E-09 2,650000 1,650000 18,39 29,999% 9,51E-16 9,51E-14

Sedimen Batu 3,17E-03 2,680000 1,680000 22,40 0,041% 3,23E-06 0,000323

Sedimen Rip-Rap 8,94E-05 2,680000 1,680000 23,20 0,018% 1,19E-09 1,19E-07

Sedimen Filter Halus 3,88E-07 2,680000 1,680000 18,88 34,970% 3,47E-11 3,47E-09

Sedimen Filter Kasar 3,81E-07 2,680000 1,680000 19,87 27,900% 2,82E-11 2,82E-09

Sedimen Random Tanah 1,91E-07 2,750000 1,750000 19,50 0,510% 1,22E-13 1,22E-11

Sedimen Inti 3,19E-09 2,650000 1,650000 18,39 29,999% 2E-15 2E-13

Surut cepat Batu 4,34E-05 2,680000 1,680000 22,40 0,007% 1,06E-10 1,06E-08

Surut cepat Filter Halus 2,01E-05 2,680000 1,680000 18,88 1,250% 3,32E-09 3,32E-07

Surut cepat Filter Kasar 6,74E-06 2,680000 1,680000 19,87 0,490% 1,55E-10 1,55E-08

Surut cepat Rip-Rap 1,07E-06 2,680000 1,680000 23,20 0,003% 2,82E-14 2,82E-12

Surut cepat Random Tanah 2,52E-07 2,750000 1,750000 19,50 0,510% 2,13E-13 2,13E-11

Surut cepat Inti 4,85E-09 2,650000 1,650000 18,39 29,999% 4,62E-15 4,62E-13
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4.4.1. Perhitungan Faktor Keamanan Bendungan 

terhadap Gejala Piping dan Boiling. 

 

Gradien Hidrolik Kritis 

 

𝑖 =  
𝑕

𝑙 
 =  

74,67

355,46
= 0,210066 

𝑖𝑐𝑟 =  
(𝐺𝑠−1)

(1+𝑒)
  

𝑖𝑐𝑟 =  
(2,68−1)

(1+0,472)
 = 1,141304 

 

Keamanan terhadap Gejala Piping 

 

FK = 
𝑖𝑐𝑟

𝑖
=  

1,141304

0,210066
 

 = 5,433079 ≥ 4,00 

 

Jadi, aman dari gejala piping ataupun boiling. 

 

4.4.2. Perhitungan Debit Rembesan yang Diijinkan 

 

Syarat, 

Q < 1% dari debit banjir rata-rata tahunan 

Debit banjir rata-rata = 1,33 m
3
/detik 

Q’ = 0,000236 m
3
/detik/m 

L = 117,46 m 

Q = 0,000236 m
3
/detik/m x 117,46 m 

= 0,02772056 m
3
/detik 

Qijin = 1,33 m
3
/detik x 1% 

  = 0,0133 m
3
/detik 

0,0133 m
3
/detik < 0,027720 m

3
/detik 

Qijin < Q 

 

Jadi debit rembesan masih belum aman 

karena debit yang terhitung melewati 

bendungan keseluruhan masih 0,01442 
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m
3
/detik lebih banyak daripada yang 

diijinkan. 
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BAB V PEMBAHASAN 

 

Dari semua hasil setiap permodelan akan dianalisis 

hubungan dari masing-masing hasil perhitungan, yaitu pola, 

kecepatan, debit rembesan, stabilitas lereng akibat rembesan 

dan batas kritis butiran material. Berikut hasil dari setiap 

permodelan dan perhitungan. 

5.1. Rembesan dan Longsoran setiap Permodelan 

Perhitungan rembesan akan diinput kan pada 

perhitungan stabilitas longsoran secara langsung, dengan 

begitu diharapkan perhitungan stabilitas lereng yang 

didapat akan lebih akurat.  

 

5.1.1. MAB (Muka Air Banjir) 

Garis rembesan yang terjadi pada permodelan ini 

sebagaimana ditunjukkan pada gambar 5.1, mengalami 

naik-turun pada awal rembesannya.  

 

 
Gambar 5.1 Pola rembesan permodelan MAB saat 

melewati material inti 
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Tabel 5.1. Rekapitulasi Hasil Perhitungan Parameter Rembesan 

(Sumber : Perhitungan) 

No. Potongan Kondisi Muka Air 
Keterangan 

PolaRembesan Kecepatan max Debit Diameter 

1 

Bendungan 

Besar 

MAB 

 

1,09 x10-3 

m/detik 

(Batu) 

8,5956 x10-4 

m3/detik 

0,000334 

cm 

 

2 MAN 

 

1,73 x10-3 

m/detik 

(Batu) 

0,0041736 

m3/detik 

0,00097 cm 

 

3 
Surut Cepat (dari MAN ke 

Intake) 

 

5,99 x10-6 

m/detik 

(Batu) 

0,00015704 

m3/detik 

2,03 x10-

9cm 

4 
Dead Storage (MAN terdapat 

sedimen) 

 

3,17 x10-3 

m/detik 

(Batu) 

0,0041766 

m3/detik 

0,00326 cm 

 

5 
Bendungan 

Kecil 
MAB 

 

2,61 x10-3 

m/detik 
(Batu) 

0,0001064 

m3/detik 

0,001441 

cm 
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Tabel 5.2. Rekapitulasi Hasil Perhitungan Longsoran 

No. Potongan 

Kondisi 

Muka 
Air 

Kelongsoran SNI 2002 

SF 
Hulu 

Bentuk 
SF 

Hilir 
Bentuk SF Keterangan 

1 

Bendungan 

Besar 

MAB 1,237 

 

1,464 

 

1,3 

Bagian 

hulu tidak 

aman 

2 MAN 1,237 

 

1,484 

 

1,5 

Hulu dan 

hilir tidak 

aman 

3 

Surut 

Cepat 

(dari 
MAN ke 

Intake) 

1,236 

 

1,487 

 

1,2 Aman 

4 

Dead 
Storage 

(MAN 

terdapat 
sedimen) 

1,565 

 

1,480 

 

1,5 

Bagian 

hilir tidak 

aman 

5 
Bendungan 

Kecil 
MAB 1,860 

 

1,689 

 

1,3 aman 

(Sumber : Perhitungan) 
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Hal ini diakibatkan karena pada awal rembesan 

paling atas tidak melewati material filter kasar dan filter 

halus yang didesain hanya sebatas elevasi +255,01 

sedangkan elevasi banjir yang diperkirakan sampai 

elevasi +256,65 ada perbedaan sekitar 1,64 m H air yang 

tidak melewati material tersebut.  

Meskipun demikian hal ini tidak terlalu 

menggentingkan dikarenakan kondisi dimana terjadi nya 

banjir yang juga berlangsung lama sangat kecil. Selain 

itu, desain juga sudah mengikuti buku panduan 

perencanaan bendungan urugan Departemen PU tahun 

1999 untuk menentukan tinggi jagaan desain dimana 

debit banjir yang digunakan adalah debit PMF (Probable 

Maximum Flood) sehingga kemungkinan terjadinya 

rembesan semacam itu sangat kecil dan tidak berlangsung 

lama. 

Dari kecepatan rembesan yang telah dihitung 

menggunakan software diketahui bahwa kecepatan 

rembesan di bagian tengah penurunan lebih cepat 

dibandingkan pada awal dan akhir penurunan. Hal ini 

diakibatkan kecepatan pada awal dan akhir penurunan 

baru saja tertahan material yang baru saja dilewati 

sedangkan pada pertengahan terdapat percepatan akibat 

perbedaan elevasi yang mengakibatkan rembesan 

diatasnya menambahkan energi jatuh, sedangkan diakhir 

penurunan terjadi penumpukan rembesan yang perlahan-

lahan menahan kecepatan yang naik sebelumnya. 

Sedangkan pada kecepatan akhir disebelah hilir 

bendungan bisa lebih tinggi dibandingkan penurunan-

penurunan sebelumnya disebabkan karena perbedaan 

elevasi yang tinggi dibandingkan sebelumnya. 

Rembesan juga mempengaruhi kestabilan lereng 

dari bendungan, dengan mengaplikasikan rembesan yang 

sebelumnya dihitung didapatkan safety of factor dari 

setiap keadaan dengan menggunakan slip surface option 

seperti digambar 5.2 untuk hulu sedangkan gambar 5.3 

untuk hilir. 
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Gambar 5.2 Input range Entry dan Exit Longsoran pada 

GeoSlope permodelan MAB Hulu 

 
Gambar 5.3 Input range Entry dan Exit Longsoran pada 

GeoSlope permodelan MAB Hilir 

Dari perhitungan didapatkan bahwa slip paling 

kritis untuk permodelan Muka Air Banjir bagian hulu 

terdapat pada bekas bendungan pengelak dimana safety of 

factor-nya adalah 1,237 sebagaimana terlihat di gambar 

5.4. 
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Gambar 5.4 Critical Slip permodelan MAB bagian Hulu  

 

 
Gambar  5.5 perbesaran gambar Critical Slip permodelan 

MAB bagian Hulu 

Berdasarkan gambar diatas gaya tekan air saat 

mencapai elevasi setinggi +256,65 atau dengan beda H 

sebesar 53,14 m mengakibatkan kestabilan lereng pada 

bagian tersebut tidak stabil. Keruntuhan terjadi pada 

semacam jalan setapak yang akan membuat gaya tekan 

potensial air lebih banyak tersalurkan daripada di lereng 

yang memiliki kemiringan tertentu. 

Sedangkan pada lereng bagian hilir memiliki 

safety of factor paling kritis sebesar 1,464 sedikit lebih 

kecil dari permodelan lainnya. Dengan begitu bisa 

disimpulkan bahwa semakin besar kekuatan yang 

menekan lereng bagian hulu (sedimen dan air elevasi 

MAB) mengakibatkan kestabilan di lereng hilir semakin 

labil. Sebagaimana terlihat di gambar 5.6, 5.7 dan 5.8. 
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Gambar 5.6 Critical Slip permodelan MAB bagian Hilir. 

 

 
Gambar 5.7 Critical Slip permodelan Mercu Spillway 

bagian Hilir. 

 

 
Gambar 5.8 Critical Slip permodelan Surut Cepat bagian 

Hilir. 

 

5.1.2. Mercu Spillway 

Rembesan yang terjadi pada permodelan mercu 

spillway lebih rapi daripada permodelan sebelumnya 

(MAB), dikarenakan pada awal rembesan masih 



122  
 

 
 

melewati material jenis filter kasar dan halus, 

sebagaimana tampak pada gambar 5.9. 

 
Gambar 5.9 Pola rembesan permodelan Mercu Spillway 

saat melewati material inti 

 
Gambar 5.10 Pola rembesan permodelan MAB saat 

melewati material inti (perbandingan) 

 

Terlihat pada lingkaran merah pada gambar 5.10, 

terdapat sebagian rembesan yang tidak melewati material 

filter kasar dan halus, sedangkan pada permodelan mercu 

spillway terlewati semua sebagaimana gambar. Hal ini 

membuat penurunan garis rembesan berbeda. 

Sedangkan untuk kestabilan lereng bagian hulu 

bendungan tidak jauh berbeda juga dengan permodelan 

sebelumnya (MAB) critical slip permodelan ini juga 

terdapat pada bekas bendungan pengelak yang memiliki 

material filter kasar dan halus sebagai penyusunnya, 

dengan safety of factor sebesar 1,237. Tidak berbeda 

dengan permodelan sebelumnya (MAB). 
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Sedangkan untuk bagian hilir terdapat perbedaan 

sekitar 0,02 dalam safety of factor paling kritis jika 

dibandingkan dengan permodelan MAB. Critical slip 

kedua permodelan juga berada ditempat yang sama 

sebagaimana terlihat di gambar 5.11. 

 
Gambar 5.11 Critical Slip hilir permodelan MAB 

 
Gambar 5.12 Critical Slip hulu permodelan Mercu 

Spillway 

Meskipun berada pada tempat yang sama 

keduanya memiliki safety of factor yang berbeda karena 

pada permodelan MAB memiliki tekanan lebih besar 

pada hulu dibandingkan permodelan mercu spillway, 

sebagaimana dijelaskan sebelumnya. 

 

5.1.3. Surut Cepat 

Ketika rembesan sudah memenuhi material 

akibat air mencapai elevasi mercu spillway dan kemudian 

mengalami penurunan secara cepat akibat debit inflow 

sungai berhenti dan intake sedang beroperasi rembesan 

akan mengalami penurunan secara drastis diawal tetapi 
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ada sebagian rembesan yang tertahan, sebagaimana di 

gambar 5.12. 

 
Gambar 5.12 Pola rembesan permodelan Surut Cepat 

 
Gambar 5.13 Pola rembesan permodelan Surut Cepat saat 

melewati material inti 

 

Terlihat sebagian besar rembesan yang tertahan 

terdapat pada material inti yang memiliki nilai k terkecil 

yaitu 2,1 x10
-9

 m/detik sedangkan pada material batu 

memiliki nilai k sebesar 0,1 m/detik. Hal ini 

menyebabkan air yang ada di material inti tertahan 

sedangkan pada material batu lebih cepat turun. Hal ini 

sangat menguntungkan karena bila tanah inti yang berada 

di samping maka safety of factor pada hulu bendungan 

akan bertambah kritis karena terdapat air yang tertahan 

pada sebagian besar lereng yang mana akan 

menambahkan berat jenis air pori sebagai kuat stabil 

lereng yang harus ditahan. 

Kestabilan lereng pada permodelan ini bagian 

hulu memiliki safety of factor paling kritis dibandingkan 

yang lainnya yaitu sebesar 1,236 dan sekali lagi berada 
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pada slip yang terdapat pada bekas bendungan pengelak, 

sebagaimana terlihat pada gambar 5.14. 

 
Gambar 5.14 Critical Slip Permodelan Surut Cepat 

bagian Hulu 

Tidak berbeda dengan permodelan - permodelan 

sebelumnya yang critical slip-nya berada pada bagian 

bekas bendungan pengelak. Akan tetapi, dengan nilai 

safety of factor sedikit lebih kritis dibandingkan 

permodelan -permodelan sebelumnya. 

 

5.1.4. Dead Storage 

Pada rembesan di permodelan dead storage 

terjadi pola yang sama dengan permodelan mercu 

spillway. Meskipun memiliki pola rembesan yang sama 

permodelan ini memiliki sedikit perbedaan pada 

kecepatan dan debit rembesan yang terjadi. Sebagaimana 

terlihat di gambar 5.15 dan 5.16. 

 
Gambar 5.15 Penurunan garis rembesan pada material 

inti permodelan Dead Storage 
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Gambar 5.16 Penurunan garis rembesan pada material 

inti permodelan Mercu Spillway 

 

Kecepatan memiliki perbedaan sekitar 7x10
-10

 

m/detik meskipun memiliki tinggi permodelan elevasi air 

yang sama, dengan permodelan sedimen yang lebih 

tinggi. Selain itu, posisi rembesan yang merupakan 

tercepat pada material inti dari masing-masing 

permodelan berada pada tempat yang berbeda. 

Debit yang terjadi juga memiliki perbedaan 

sekitar 2,6 x10
-10

 m
3
/detik dan juga permodelan sedimen 

lagi yang lebih cepat. 

Kestabilan pada lereng hulu memiliki Safety of 

factor yang lebih baik dibandingkan lereng hilirnya. Pada 

lereng hulu safety of factor paling kritis senilai 1,565 

(Gambar 5.17). Sedangkan pada lereng hilir memiliki 

safety of factor longsoran sebesar 1,480 (Gambar 5.18) 

serta 1,490 (Gambar 5.19) di perhitungan kritis 

setelahnya dimana kedua SF tersebut tidak memenuhi 

SNI 2002. 

 
Gambar 5.17 Longsoran Kritis permodelan Dead Storage 

Sebelah Hulu 
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Gambar 5.18 Longsoran Kritis permodelan Dead Storage 

Sebelah Hilir 1 

 
Gambar 5.19 Longsoran Kritis permodelan Dead Storage 

Sebelah Hilir 2 

 

5.1.5. MAB Bendungan Potongan Kecil 

Debit rembesan yang melewati material inti 

mengalami perbedaan jumlah yang cukup besar, hal ini 

dikarenakan perbedaan panjang lintasan serta beda 

elevasi rembesan yang terjadi. Panjang lintasan yang 

pada permodelan MAB, Mercu Spillway dan Dead 

Storage sepanjang 32,25 m, sedangkan pada permodelan 

ini hanya sepanjang 8,51 m. Hal ini dikarenakan bentuk 

dari rembesan yang berbeda dari permodelan lainnya. 

Permodelan lain memiliki penurunan rembesan 

yang sangat curam dibandingkan permodelan ini. 

Sebagaimana dijelaskan sebelumnya, sehingga penyusun 

memutuskan panjang lintasan hanya sepanjang 8,51 m, 

menyejajarkan dengan garis batas rembesan. 

Terjadi perbedaan kecepatan yang cukup jauh 

pada peralihan tubuh bendungan dan dengan tanah 

pondasi bendungan, berbeda dengan potongan besar yang 

diberi grouting sehingga perbedaan kecepatan tidak 
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terlalu besar. Akan tetapi pada potongan kecil masih 

terdapat perbedaan tersebut karena tidak adanya grouting. 

Longsoran pada permodelan ini tergolong aman 

karena selain memiliki nilai safety of factor aman ukuran 

longsornya juga kecil baik yang hilir maupun hulu. Pada 

bagian hulu memiliki safety of factor paling kritis sebesar 

1,860 dengan ukuran longsornya seperti pada gambar 

5.20. Sedangkan  pada hilir sebesar 1,683 sebagaimana 

terlihat pada gambar 5.21. 

 
Gambar 5.20 Longsoran Paling Kritis Permodelan MAB 

Potongan Kecil Bendungan Hulu 

 
Gambar 5.21 Longsoran Paling Kritis Permodelan MAB 

Potongan Kecil Bendungan Hilir 

 

5.2. Material dan Batas Diameter Kritis Butirnya 

Dengan 6 jenis material penyusun bendungan 

yang terdiri dari material inti, filter halus, filter kasar, 

batu, random tanah, dan rip-rap. Dari perhitungan yang 

didapat sebelumnya yang dihitung menggunakan rumus 

batas kecepatan kritis yang dikonversikan untuk 

mendapatkan diameter kritis dari kecepatan rembesan 

yang terjadi. Sebagaimana ditunjukkan dalam tabel 5.1 
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Tabel 5.1. Perhitungan Batas Kritis Diameter

 
(Sumber: Perhitungan) 

 

Dari hasil perhitungan pada tabel 5.1. terlihat 

bahwa kecepatan rembesan paling tinggi terdapat pada 

permodelan MAB dengan material yang terlewati saat 

kecepatan terjadi adalah di material batu dan selanjutnya 

permodelan Sedimen yang juga saat melewati material 

batu, serta 7 urutan selanjutnya juga merupakan material 

batu dan rip-rap. Kedua material tersebut merupakan 

material dengan nilai k paling tinggi, sehingga wajar jika 

memiliki kecepatan rembesan yang tinggi.  

Material batu (kerikil) yang memiliki diameter 

butir relatif besar yaitu antara 50-5 mm. Karena besarnya 

butiran tersebut kecil kemungkinan akan terbawa 

rembesan, serta berdasarkan perhitungan pada tabel 

butiran yang terbesar yang akan terbawa dengan 

kecepatan rembesan yang didapat sebelumnya adalah 

Permodelan Material Vc Gs Gs-1 γ(gr/cm) w d (m) d (cm)

MAB Batu 1,09E-03 2,680000 1,680000 22,40 0,041% 3,86E-07 3,86E-05

Sedimen Batu 3,17E-03 2,680000 1,680000 22,40 0,041% 3,23E-06 0,000323

MAN Batu 1,73E-03 2,680000 1,680000 22,40 0,041% 9,58E-07 9,58E-05

MAN Rip-Rap 7,98E-04 2,680000 1,680000 23,20 0,000% 9,51E-10 9,51E-08

MAB Rip-Rap 1,97E-04 2,680000 1,680000 23,20 0,000% 5,77E-11 5,77E-09

Sedimen Rip-Rap 8,94E-05 2,680000 1,680000 23,20 0,018% 1,19E-09 1,19E-07

MAB kecil Batu 8,06E-05 2,680000 1,680000 22,40 0,410% 1,81E-07 1,81E-05

Surut cepat Batu 4,34E-05 2,680000 1,680000 22,40 0,007% 1,06E-10 1,06E-08

MAB kecil Filter Kasar 3,31E-05 2,680000 1,680000 19,87 27,900% 1,37E-07 1,37E-05

Surut cepat Filter Halus 2,01E-05 2,680000 1,680000 18,88 1,250% 3,32E-09 3,32E-07

MAB kecil Rip-Rap 1,77E-05 2,680000 1,680000 23,20 0,018% 1,44E-05 0,001441

MAN Filter Kasar 1,26E-05 2,680000 1,680000 19,87 27,900% 3,08E-08 3,08E-06

MAB Filter Halus 6,82E-06 2,680000 1,680000 18,88 34,970% 1,08E-08 1,08E-06

Surut cepat Filter Kasar 6,74E-06 2,680000 1,680000 19,87 0,490% 1,55E-10 1,55E-08

MAB Filter Kasar 6,54E-06 2,680000 1,680000 19,87 27,900% 8,31E-09 8,31E-07

MAB kecil Filter Halus 6,37E-06 2,680000 1,680000 18,88 34,970% 1,16E-08 1,16E-06

MAN Filter Halus 1,38E-06 2,680000 1,680000 18,88 34,970% 4,41E-10 4,41E-08

Surut cepat Rip-Rap 1,07E-06 2,680000 1,680000 23,20 0,003% 2,82E-14 2,82E-12

MAN Random Tanah 6,28E-07 2,750000 1,750000 19,50 0,005% 1,32E-14 1,32E-12

MAB Random Tanah 5,63E-07 2,750000 1,750000 19,50 0,005% 1,06E-14 1,06E-12

Sedimen Filter Halus 3,88E-07 2,680000 1,680000 18,88 34,970% 3,47E-11 3,47E-09

Sedimen Filter Kasar 3,81E-07 2,680000 1,680000 19,87 27,900% 2,82E-11 2,82E-09

Surut cepat Random Tanah 2,52E-07 2,750000 1,750000 19,50 0,510% 2,13E-13 2,13E-11

Sedimen Random Tanah 1,91E-07 2,750000 1,750000 19,50 0,510% 1,22E-13 1,22E-11

Surut cepat Inti 4,85E-09 2,650000 1,650000 18,39 29,999% 4,62E-15 4,62E-13

Sedimen Inti 3,19E-09 2,650000 1,650000 18,39 29,999% 2E-15 2E-13

MAN Inti 2,20E-09 2,650000 1,650000 18,39 29,999% 9,51E-16 9,51E-14

MAB Inti 1,49E-09 2,650000 1,650000 18,39 29,700% 4,32E-16 4,32E-14

MAB kecil Inti 6,96E-10 2,650000 1,650000 18,39 29,999% 6,57E-11 6,57E-09
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3,8615 x10
-4

 mm, jauh lebih kecil dari diameter terkecil 

butiran batu. 

Selain itu, material inti yang memiliki butiran 

paling kecil diantara material yang lainnya, didapati 

permodelan yang memiliki kecepatan paling tinggi 

adalah saat dimodelkan surut cepat yang mana 

permodelan ini jarang terjadi di lapangan. Dengan 

kecepatan rembesan sebesar 4,85 x10
-9

 m/detik dan dari 

kecepatan tersebut didapat diameter butir paling besar 

yang akan terbawa akibat kecepatan tersebut sebesar 

4,624 x10
-11

 mm. Sedangkan menurut tabel klasifikasi 

butiran tanah menurut Unified Soil Classification System, 

ASTM, MIT dan Internasional Nomenclature diameter 

butir lempung halus memiliki ukuran 0,0002 mm, 

sehingga dipastikan aman dari gejala sufosi maupun 

boiling. 

 

5.3. Rembesan dan Batas Kecepatan Kritis 

Kecepatan rembesan didapat dari perhitungan 

menggunakan software GeoStudio SEEP/W. Dari 

keseluruhan didapat rembesan dengan kecepatan paling 

cepat dominan terjadi pada material batu dan rip-rap dari 

setiap permodelan hal ini tentu saja sudah menjadi 

kewajaran dikarenakan nilai k dari material tersebut yang 

paling tinggi dari keseluruhan material. Dan permodelan  

yang memiliki kecepatan rembesan paling rendah adalah 

permodelan surut cepat. Hal ini dikarenakan permodelan 

tersebut sempat mengalami penurunan elevasi yang 

otomatis menyebabkan penurunan energi potensial dari 

rembesan kecuali pada bagian material inti. Sebagian 

masih memiliki energi potensial yang cukup tinggi pada 

bagian yang tertahan oleh material inti, yang pada 

akhirnya memiliki kecepatan tertinggi untuk yang 

melewati material inti dibandingkan dengan permodelan 

yang lain. 

Berdasarkan buku Panduan Perencanaan 

Bendungan Urugan Vol. 3 Desain Pondasi & Tubuh 
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Bendungan, koefisien filtrasi (K) dari bahan untuk zona 

kedap air tidak melebihi nilai 1 x 10
-5

 cm/detik dan untuk 

amannya dianjurkan agar menggunakan bahan dengan 

nilai K yang tidak melebihi 1 x 10
-5

 cm/detik.  

Sesuai dengan panduan,  urugan Bendungan 

Tugu Kabupaten Trenggalek menggunakan tanah 

lempung dengan nilai K kurang dari 2,1 x 10
-7

 cm/detik. 

Sedangkan diameter dari butiran tidak bisa ditentukan 

dikarenakan desain bendungan yang masih belum resmi 

dan masih mengalami perubahan beberapa kali. Akan 

tetapi desain yang digunakan untuk permodelan tidak 

terlalu diperlukan karena pada perhitungan rembesan 

hanya memerlukan nilai K material tersebut. 
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“Halaman ini sengaja dikosongkan” 
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BAB VI KESIMPULAN 

 

6.1.  Kesimpulan 

1. Debit rembesan yang terjadi dengan merata-rata 

rembesan yang terjadi pada bendungan potongan 

besar (STA 7) dan bendungan potongan kecil (STA 

17) sebesar 0,027765  m
3
/detik yang terjadi pada 

kaki hilir bendungan. Diketahui tidak aman karena 

melebihi 1% dari debit banjir tahunan yaitu 0,0133 

m
3
/detik (1% dari 1,33 m

3
/detik). 

2. Dari perhitungan batas kritis diameter butir 

diketahui bahwa kecepatan rembesan paling tinggi 

terdapat di permodelan MAB dengan butir paling 

besar yang akan terbawa akibat kecepatan tersebut 

sebesar 3,85 x10
-4

 mm pada material batu. 

Sedangkan diameter paling kritis yang akan terbawa 

(paling besar) ada pada permodelan MAB potongan 

kecil (STA 17) sebesar 0,0144 mm.   

3. Safety of factor longsoran paling kritis terdapat pada 

permodelan surut cepat sebesar 1,236, akan tetapi 

masih memenuhi SNI 2002 yang harus lebih besar 

dari 1,200. 

4. Terdapat 3 permodelan yang tidak memenuhi angka 

yang ditentukan SNI 2002 untuk kategori masing-

masing yaitu : 

 MAB Hulu (1,237 < 1,3) 

 MAN Hulu dan Hilir (1,237; 1,484 < 1,5) 

 Dead Storage Hilir (1,480 < 1,5) 

5. Safety of Factor gejala sufosi dan boiling 

menunjukan angka sebesar 5,433079 yang mana 

lebih besar dari angka batas aman dari gejala 

tersebut yaitu 4,00 sehingga dinyatakan aman. 
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6.2. Saran 

1. Untuk penelitian selanjutnya supaya mengumpulkan 

data tanah yang lebh lengkap agar menghasilkan 

analisa yang lebih akurat. 

2. Analisa dengan program masih memiliki kelemahan 

sehingga untuk mendapatkan hasil yang lebih akurat 

terlebih dahulu harus dibandingkan dengan metode 

yang lain, terutama secara manual ataupun dengan 

program lain, seperti rheo staub, Plaxis, dll. 

3. Geostudio dan program analisa yang lain hanyalah 

sebuah instrumen, sehingga hasil dari analisanya 

sangat tergantung pada pengetahuan, keahlian dan 

pengalaman dalam  menganalisa dan 

menterjemahkan data-data yang ada menjadi input 

yang benar sesuai dengan kondisi nyatanya. 
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LAMPIRAN 

Rembesan Hasil Perhitungan Kondisi MAB (+256,65) 

 

 

 

 

 

 

 



  
 

 
 

Rembesan Hasil Perhitungan Kondisi Mercu Spillway (+250,60) 

 

 

 

 

 

 

 



 
 

 
 

Rembesan Hasil Perhitungan Kondisi Surut Cepat (+250,60 - +215,50) 

 

 

 

 

 

 

 



  
 

 
 

Rembesan Hasil Perhitungan Kondisi Dead Storage (+250,60) 

 

 

 

 

 

 

 



 
 

 
 

Rembesan Hasil Perhitungan Kondisi MAB Permodelan STA 17 (+256,65) 
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